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General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to this product or any products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Use proper power cord. Use only the power cord specified for this product and certified for the country of use.

Ground the product. This product is grounded through the grounding conductor of the power cord. To avoid electric
shock, the grounding conductor must be connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult the
product manual for further ratings information before making connections to the product.

Power disconnect. The power cord disconnects the product from the power source. Do not block the power cord; it
must remain accessible to the user at all times.

Do not operate without covers. Do not operate this product with covers or panels removed.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected by
qualified service personnel.

Avoid exposed circuitry. Do not touch exposed connections and components when power is present.

Do not operate in wet/damp conditions.

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry.
Provide proper ventilation. Refer to the manual’s installation instructions for details on installing the product so it has
proper ventilation.

PQA600 Quick Start User Manual iii



General Safety Summary

Terms in This Manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Symbols and Terms on the Product
These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the marking.

WARNING indicates an injury hazard not immediately accessible as you read the marking.

CAUTION indicates a hazard to property including the product.

The following symbol(s) may appear on the product:
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Compliance Information

Compliance Information
This section lists the EMC (electromagnetic compliance), safety, and environmental standards with which the instrument
complies.

EMC Compliance
EC Declaration of Conformity – EMC
Meets intent of Directive 2004/108/EC for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

EN 61326-1 2006. EMC requirements for electrical equipment for measurement, control, and laboratory use. 1 2

CISPR 11:2003. Radiated and conducted emissions, Group 1, Class A

IEC 61000-4-2:2001. Electrostatic discharge immunity

IEC 61000-4-3:2002. RF electromagnetic field immunity

IEC 61000-4-4:2004. Electrical fast transient / burst immunity

IEC 61000-4-5:2001. Power line surge immunity

IEC 61000-4-6:2003. Conducted RF immunity

IEC 61000-4-11:2004. Voltage dips and interruptions immunity

EN 61000-3-2:2006. AC power line harmonic emissions

EN 61000-3-3:1995. Voltage changes, fluctuations, and flicker

European Contact.
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

1 This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic interference.

2 Emissions which exceed the levels required by this standard may occur when this equipment is connected to a test object.

Australia / New Zealand Declaration of Conformity – EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

CISPR 11:2003. Radiated and Conducted Emissions, Group 1, Class A, in accordance with EN 61326-1:2006.
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Compliance Information

Safety Compliance
EC Declaration of Conformity – Low Voltage
Compliance was demonstrated to the following specification as listed in the Official Journal of the European Communities:

Low Voltage Directive 2006/95/EC.

EN 61010-1: 2001. Safety requirements for electrical equipment for measurement control and laboratory use.

U.S. Nationally Recognized Testing Laboratory Listing
UL 61010-1:2004, 2nd Edition. Standard for electrical measuring and test equipment.

Canadian Certification
CAN/CSA-C22.2 No. 61010-1:2004. Safety requirements for electrical equipment for measurement, control, and
laboratory use. Part 1.

Additional Compliances
IEC 61010-1: 2001. Safety requirements for electrical equipment for measurement, control, and laboratory use.

Equipment Type
Test and measuring equipment.

Safety Class
Class 1 – grounded product.

Pollution Degree Description
A measure of the contaminants that could occur in the environment around and within a product. Typically the internal
environment inside a product is considered to be the same as the external. Products should be used only in the environment
for which they are rated.

Pollution Degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally
encapsulated, hermetically sealed, or located in clean rooms.

Pollution Degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is
caused by condensation must be expected. This location is a typical office/home environment. Temporary condensation
occurs only when the product is out of service.

Pollution Degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation.
These are sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct
sunshine, rain, or direct wind.

Pollution Degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical
outdoor locations.
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Compliance Information

Pollution Degree
Pollution Degree 2 (as defined in IEC 61010-1). Note: Rated for indoor use only.

Installation (Overvoltage) Category Descriptions
Terminals on this product may have different installation (overvoltage) category designations. The installation categories are:

Measurement Category IV. For measurements performed at the source of low-voltage installation.

Measurement Category III. For measurements performed in the building installation.

Measurement Category II. For measurements performed on circuits directly connected to the low voltage installation.

Measurement Category I. For measurements performed on circuits not directly connected to MAINS.

Overvoltage Category
Overvoltage Category II (as defined in IEC 61010-1)
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Compliance Information

Environmental Considerations
This section provides information about the environmental impact of the product.

Product End-of-Life Handling
Observe the following guidelines when recycling an instrument or component:

Equipment Recycling. Production of this equipment required the extraction and use of natural resources. The
equipment may contain substances that could be harmful to the environment or human health if improperly handled at the
product’s end of life. In order to avoid release of such substances into the environment and to reduce the use of natural
resources, we encourage you to recycle this product in an appropriate system that will ensure that most of the materials are
reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according
to Directives 2002/96/EC and 2006/66/EC on waste electrical and electronic equipment (WEEE) and
batteries. For information about recycling options, check the Support/Service section of the Tektronix Web
site (www.tektronix.com).

Battery Recycling. This product may contain a rechargeable battery, which must be recycled or disposed of properly.
Please properly dispose of or recycle the battery according to local government regulations.

Perchlorate Materials. This product contains one or more type CR lithium batteries. According to the state
of California, CR lithium batteries are classified as perchlorate materials and require special handling. See
www.dtsc.ca.gov/hazardouswaste/perchlorate for additional information.

Transporting Batteries
The capacity of the lithium ion rechargeable battery pack in this product is under 100 Wh. The lithium-equivalent content, as
defined by the UN Manual of Tests and Criteria Part III Section 38.3, is under 8 g per pack and 1.5 g per individual cell.
Consult your air carrier for applicability and determination of any special lithium ion battery transportation requirements.

Restriction of Hazardous Substances
This product is classified as Monitoring and Control equipment, and is outside the scope of the 2002/95/EC RoHS Directive.
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Preface

Preface

About This Manual
This manual describes the installation and basic operation of the PQA600 Picture Quality Analyzer with Version 3.0 software.

Key Features
The PQA600 analyzer is the latest-generation Picture Quality Analyzer built on the Tektronix’ Emmy Award winning
PQA200/300 Picture Quality Analyzers. Based on concepts of the human vision system, the PQA600 analyzer provides a
suite of repeatable, objective quality measurements that closely correspond with subjective human visual assessment:

Fast, accurate, repeatable, objective picture quality measurement

Predicts DMOS (Differential Mean Opinion Score) measurement based on model of the human vision system

Picture quality measurements can be made on a variety of HD video formats (1080i, 720p) and SD video formats
(525 or 625 )

Ability to make picture quality comparison across different resolutions from HD to SD, or HD/SD to CIF

User-configurable viewing condition and display models for reference and comparison

Attention/Artifact weighted measurement

Automatic temporal and spatial alignment

Easy regression testing and automation with XML scripting

Optional SD/HD SDI Interface for generating and capturing video

Documentation
To read about Use these documents
Installation and operation (overviews) PQA600 Picture Quality Analyzer Quick Start User Manual. The quick start

user manual contains general information about how to put your instrument
into service, guides to user interface controls, and application examples.

In-depth reference information PQA600 Picture Quality Analyzer System Technical Reference. The
technical reference contains detailed information about the instrument,
including how measurements are calculated and specifications.

PC platform information Refer to the PC platform documentation for full information on the PC
platform hardware and software. The PC platform documentation is
provided on a CD.
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Software Upgrades
Periodic software upgrades might become available.

To check for upgrades:

1. Go to the Tektronix Web site (www.tektronix.com).

2. Select Software and Drivers to link to the Software and Firmware Finder Web page.

3. Enter the product name (PQA600) to find available software upgrades.

Conventions Used in This Manual
The following icons are used throughout this manual.

Sequence
Step

Front panel
power

Connect
power

Network PS2 SVGA USB
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Installing Your Instrument

Installing Your Instrument
This section contains information on installing your instrument. Unpack the instrument and check that you received all items
listed as Standard Accessories. Check that you also received any of the listed Recommended Accessories that you ordered
with your instrument. Check the Tektronix Web site (www.tektronix.com) for the most current information.

Standard Accessories

Accessory
Tektronix part
number

PQA600 Picture Quality Analysis System Quick Start User Manual in English, and Simplified
Chinese or Japanese translation if a language option was ordered

071-2775-XX

PQA600 Picture Quality Analysis System Release Notes 071-2781-XX
PQA600 Picture Quality Analysis System User Technical Reference, in PDF format on
Documentation CD

071-2778-XX

PQA600 Picture Quality Analysis System Measurement Technical Reference 071-2779-XX
PQA600 Picture Quality Analysis System Specification and Performance Verification Manual in PDF
format on Product Documentation CD

077-0487-XX

PQA600 Picture Quality Analysis System Measurement Declassification and Security Instructions in
PDF format on Tektronix Web site, www.tektronix.com/manuals

077-0486-XX

PQA600 Picture Quality Analysis System Product Documentation CD, containing PDF files of the
documentation set

063-4284-XX

PQA600 Picture Quality Analysis System Application Install CD 020-3054-XX
PQA600 Picture Quality Analysis System Video Sequences Recovery Disks 020-3053-XX
Dell Operating System Reinstallation DVD (Windows 7 Professional 64–Bit) — — —
Dell Application CD — — —
Dell keyboard — — —
Dell optical mouse — — —
Dell Warranty and Support Information, and Safety, Environmental, and Regulatory Information
booklets

— — —

Roxio Creator DE CD — — —
BNC to mini-BNC SDI cable (Option SDI only) 174-5466-XX

North America (Option A0) 161-0066-00
Universal Euro (Option A1) 161-0066-09
United Kingdom (Option A2) 161-0066-10
Australia (Option A3) 161-0066-13
North America 240V (Option A4) 161-0066-12
Switzerland (Option A5) 161-0154-00
Japan (Option A6) 161-0298-00
China (Option A10) 161-0304-00
India (Option A11) 161-0324-00

Power Cord

No power cord or AC adapter (Option A99) — — —
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Options
You can add the following option to your Picture Quality Analyzer System:

Option SDI - Adds SD/HD SDI Acquisition Card

Language Options
You must select one of the following language options for your Picture Quality Analysis System:

Option L0 - English Quick Start User Manual

Option L5 - Japanese Quick Start User Manual

Option L7 - Simplified Chinese Quick Start User Manual
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Operating Requirements
1. Place the instrument on a bench.

2. Before operating, ensure that the ambient temperature is between +50 °F and +95 °F (+10 °C to +35 °C).

CAUTION. To ensure proper cooling, keep the front and rear of the instrument clear of obstructions.

Installing the System
This section provides basic information about performing the PQA600 analyzer installation. For detailed information about
the PC workstation hardware, see the documentation provided on the Dell T7500 Documentation CD.

Hardware Prerequisites
Before installation, ensure that the following are available:

Mains power, 115V/230 V, 50/60 Hz, 6A/3A. See Power Supply Requirements.

Clearance around the unit to allow proper airflow

An RJ45 network connection between the Gigabit Ethernet port and your network.

An appropriate display monitor. The PQA600 analyzer is not supplied with a monitor, though it is configured with
a high-performance video card.

CAUTION. To prevent personal injury, always use two people to move the PQA600 analyzer.
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Installation Procedure

To install the PQA600 analyzer, perform the following generalized procedure:

1. Connect a display monitor to the video card connector on the rear panel.

2. Attach the keyboard and mouse using the USB-to-PS2 adapters to connect to the PS2 ports on the rear panel.

3. Connect power to the PQA600 analyzer.

4. Press the power button on the front panel.

5. To access the PC, click the PQA600 account icon. No password is required.
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Powering On the Instrument
The following table lists the operating voltage requirements for the PQA600 instrument. All voltages are RMS values.

Power supply requirements
Source voltage Frequency Maximum Rated Input Current
115/230 50–60 12 Amps.

NOTE. Connect the power cord (provided with the unit) to the power connector on the rear panel. Then connect the
power cord plug to a properly grounded outlet.

To power on the instrument (after making all connections):

1. Attach the power cord to the rear panel.

2. Press the power button on the front
panel.

Shutting Down the Instrument
To shut down the instrument:

1. Select Start > Shutdown.

2. Select Shutdown from the drop-down list in the Shutdown Windows dialog and then select OK.

Removing the Power
To remove power from the instrument:

1. Shut down the instrument.

2. After Windows has completed the shutdown process, remove the power cord from the rear panel.

Connecting to a Network
You can connect your instrument to a network for printing, file sharing, internet access, and other functions. Consult with your
network administrator and use the standard Windows utilities to configure the instrument for your network.
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Operating Your Instrument

Getting Acquainted with Your Instrument
Controls and display elements are shown in the following illustrations and tables.

Front Panel Indicators

Ref number Item Description
1 Optical drive DVD-R/W optical drive
2 Drive activity light Random blinking light indicates hard disk drive activity

Blinking green light indicates network activity
3 USB 2.0 connectors USB 2.0 compliant ports
4 IEEE 1394 Connector for attaching external iEEE 1394 compliant devices
5 Diagnostic lights Refer to Dell documentation for details
6 Power button Turns the instrument on or off
7 Microphone connector Used to attach a microphone
8 Headphone connector Used to attach headphones
9 Link integrity indicator Refer to Dell documentation for details
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Rear Panel Connectors

Ref number Item Description
1 Video I/O card (optional) SD/HD SDI Video I/O card. (Option SDI only)
2 Network card Ethernet network card
3 Video display card Dual-link DVI video display card
4 USB ports USB 2.0 connectors (6)
5 Mouse and keyboard

connectors
PS/2 mouse and keyboard connectors

6 IEEE 1394 connector IEEE 1394 high-speed serial bus interface connector
7 Serial port Serial port connector
8 Parallel port Parallel port connector
9 eSATA connector eSATA interface connector
10 Line in and line out

connectors
Line-level audio input and output connectors

11 Network adapter Ethernet network interface connector
12 Power connector AC line connector
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Software Interface and Display Elements

Ref number Item Description
1 Measure button The Measure button performs multiple functions. Use it to display the

Configure Measure window (which allows you to select or configure
measurements), to initiate measurements, and to stop currently running
measurements.

2 SDI Generate/Capture
button

Use the SDI Generate/Capture button to generate a video output signal or
capture a video input signal into a file (requires Option SDI).

3 Current button Use the Current button to change the view to Current. In the Current
view, you can configure and run measurements. You can also click this
button to switch between reviewing results and checking the progress
of a running measurement.

4 Review button Use the Review button to change the view to Review. In the Review view,
you can select video clips for review and analysis. You can use this button
while a measurement is running to review results, though you cannot view
running measurement results until they are complete.

5 Summary View button Select to display the Summary View screen. The Summary View screen
shows the reference video, test video, map, and the graph display.

6 Tile View button Select to display the Tile View screen. The Tile View screen shows three
screens in a horizontal arrangement: the reference video at the top, the
test video in the middle, and the map at the bottom.
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Ref number Item Description
7 Overlay View button Select to display the Overlay View screen. The Overlay View screen

mixes two sources for display. Using a slide bar, you can specify which
source makes up most of the display.

8 Event Log Select to display the Event Log screen. The Event Log displays
measurements which exceed the settings for warnings and errors.

9 Configure button Use the Configure button to control the Output Spatial ROI settings.
10 Update Graphs button Use the Update Graphs button to recalculate measurements after you

specify the Output Spatial ROI boundary.
11 Control bar Controls the playback of video. Functions like the playback controls on a

videotape or DVD player.
12 Units selector Sets the selector bar to select video frames by frame number or elapsed

time.
13 SDI Out Select to output the Reference file to the Ch 1 connectors and output the

Test file to the Ch 2 output connectors while reviewing the measurement
results (or in review mode).

14 Frame selector Use this slider bar to select which frame of the video clip to display.
15 Frame/Time readout The readout indicates the display frame-by-frame number or time. You

can also enter a frame number or time to display into this readout.
16 Measurement readout The readout displays the minimum, maximum, and overall values for the

selected measurement.
17 Navigation pane The Navigation Pane is used to select measurement results for review.
18 Results path The Results Path readout shows the path to the directory containing the

selected measurement results file.

Table 1: Elements of the menu bar
Menu Command Description
File Working Directories Use to add directories to the Navigation Pane.

Update Sequence List Use to update contents of directories in the
Navigation Pane.

Import Measures Use to import user configured measures that have
been saved in another location or PQA600.

Print Sends a screen capture of the PQA600 application
window to the printer.

Exit Quits the PQA600 application.
View Current Measure Sets the View to Current.

Review Sets the View to Review.
Summary View Sets the display area to Summary View.
Tile Sets the display area to Tile View.
Overlay Sets the display area to Overlay View.
Event Log Sets the display area to the Event Log.
Result 1 Selects which sources are displayed in the

Overlay view as Result 1.
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Table 1: Elements of the menu bar (cont.)

Menu Command Description
Result 2 Selects which sources are displayed in the

Overlay view as Result 2 (two results files must
be selected to display two results).

Loop Sets playback to loop mode.
Configure Measures Displays the Configure Measures window to

enable you to create and configure measurements.
Generation/Capture Displays the Capture window to enable you to

configure Capture settings.
Display Settings Displays the Display Settings window. From

the Display settings window, you can set the
brightness and contrast for result maps, specify
the colors used in the Summary View Graph, and
set videos to fit the window.

Execute Measures Initiates a measurement.
Help Tektronix Home Page Displays the Tektronix Web site in a browser

window.
About the PQA600 Displays information about the PQA600 Picture

Quality Analyzer.
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Starting or Exiting the Software
To start the PQA600 application software:

Select Start > Programs >Tektronix > PQA600 or double-click the desktop icon.

To exit the PQA600 application software:

Select File > Exit.

The Analysis Process
Analyzing picture quality with the PQA600 analyzer is, broadly speaking, a two step process. First, you take a measurement
and second, you review the analysis results. Once the measurement is complete, you can choose several ways to
review the results.

In taking a measurement, you select a measurement (either a template measurement or a user-created measurement) from
the Configure Measure dialog box. After selecting the measurement, you specify the video file(s) on which the measurement
will be taken. Some measurements apply to a single file, though most compare a test file to a reference file. Once you have
specified the video files on which to take the measurement, you initiate the measurement.

Selecting a Measurement
To select a measurement:

1. Click Measure to display the Configure Measure dialog box.

2. Select a measurement from the list of Measures.

Table 2: Measurements and their processing nodes

Measurement Name
Display
Model

View
Model PSNR

Perceptual
Difference

Artifact
Detection

Attention
Model

Summary
Node

000 View Video — — — — — — —
001 SD Broadcast
PQR

— — —

002 HD Broadcast
PQR

— — —

003 CIF and QVGA
PQR

— — —

004 D-CINEMA PQR — — —
005 SD Broadcast
DMOS

— — —

006 HD Broadcast
DMOS

— — —

007 CIF and QVGA
DMOS

— — —

008 D-CINEMA
DMOS

— — —
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Table 2: Measurements and their processing nodes (cont.)

Measurement Name
Display
Model

View
Model PSNR

Perceptual
Difference

Artifact
Detection

Attention
Model

Summary
Node

009 SD Broadcast
ADMOS

— —

010 HD Broadcast
ADMOS

— —

011 CIF and QVGA
ADMOS

— —

012 SD Sports
Broadcast ADMOS

— —

013 HD Sports
Broadcast ADMOS

— —

014 Talking Head
Broadcast ADMOS

— —

015 SD DVD from
D-Cinema DMOS

— — —

016 CIF from SD
Broadcast DMOS

— — —

017 SD from HD
Broadcast DMOS

— — —

017-A Reference:
SD, Test: HD
Broadcast DMOS

— — —

018 QCIF from CIF
and QVGA DMOS

— — —

019 Stand-alone
Attention Model

— — — — —

020 PSNR dB — — — — —
021 Removed Edges
Percent

— — — —

022 Added Edges
Percent

— — — —

023 Rotated Edges
Percent

— — — —

024 DC Blocking
Percent

— — — —

025 Removed Edges
Weighted PSNR dB

— — —

026 Added Edges
Weighted PSNR dB

— — —

027 Rotated Edges
Weighted PSNR dB

— — —

028 DC Blocking
Weighted PSNR dB

— — —
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Table 2: Measurements and their processing nodes (cont.)

Measurement Name
Display
Model

View
Model PSNR

Perceptual
Difference

Artifact
Detection

Attention
Model

Summary
Node

029 Artifact
Annoyance
Weighted PSNR
dB

— — —

030 SD DVD from
D-Cinema Artifact
Weighted PSNR dB

— — —

031 CIF from SD
Broadcast Artifact
Weighted PSNR dB

— — —

032 SD from HD
Broadcast Artifact
Weighted PSNR dB

— — —

033 QCIF from CIF
and QVGA Artifact
Weighted PSNR dB

— — —

034 Attention
Weighted PSNR
dB

— — — —

035 No Reference
DC Blockiness
Percent

— — — — —

036 HD ADMOS
ITU-BT500 with
Interlaced CRT

— —

037 HD PQR
ITU-BT500 with
Interlaced CRT

— — —

038 HD DMOS
ITU-BT500 with
Interlaced CRT

— — —
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Template Measurements
The PQA600 application software is configured with 38 template measurements. These measurements are optimized
for a variety of uses. Although you cannot change the parameters of the template measurements, you can create new
measurements based on a template measurement and save the new measurement under a different name. Measurements
are defined through a series of configuration nodes. You change measurement parameters by selecting a configuration
node and adjusting its settings to suit your requirements.

NOTE. To accurately simulate the procedure called out in the ITU BT.500 standard, all DMOS predictions require a worst
case training. To provide this training, take the selected DMOS measurement once with an example of the worst case
video expected for the application according to ITU BT.500 worst case training recommendations. After you have taken
the measurement, use the Import function in the Summary Node for the measurement to import the Minkowski value from
the measurement results csv file.

Table 3: Template measurements
Measurement Class Measurement Name

000 View Video
Subjective Prediction: Full Reference

Noticeable Differences
SD Display and Viewing 001 SD Broadcast PQR
HD Display and Viewing 002 HD Broadcast PQR
CIF Display and Viewing 003 CIF and QVGA PQR
D-Cinema Projector and Viewing 004 D-CINEMA PQR

Subjective Rating Predictions
SD Display and Viewing (with preliminary BT.500
training)

005 SD Broadcast DMOS

HD Display and Viewing (with preliminary BT.500
training)

006 HD Broadcast DMOS

CIF Display and Viewing (with preliminary BT.500
training)

007 CIF and QVGA DMOS

D-Cinema Projector and Viewing (with preliminary
BT.500 training)

008 D-CINEMA DMOS

Attention Biased Subjective Rating Predictions
SD Display and Viewing (with preliminary BT.500
training)

009 SD Broadcast ADMOS

HD Display and Viewing (with preliminary BT.500
training)

010 HD Broadcast ADMOS

CIF Display and Viewing (with preliminary BT.500
training)

011 CIF and QVGA ADMOS

SD Sports (with preliminary BT.500 training) 012 SD Sports Broadcast ADMOS
HD Sports (with preliminary BT.500 training) 013 HD Sports Broadcast ADMOS
SD Talking Head (with preliminary BT.500
training)

014 SD Talking Head Broadcast ADMOS
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Table 3: Template measurements (cont.)

Measurement Class Measurement Name
Repurposing: Reference and test are independent: Use any combination display model and viewing conditions
with each measurement above

Format Conversion: Cinema to SD DVD (with
preliminary BT.500 training)

015 SD DVD from D-Cinema DMOS

Format Conversion: SD to CIF (with preliminary
BT.500 training)

016 CIF from SD Broadcast DMOS

Format Conversion: HD to SD (with preliminary
BT.500 training)

017 SD from HD Broadcast DMOS

Format Conversion: SD to HD (with preliminary
BT.500 training)

017-A HD from SD Broadcast DMOS

Format Conversion: CIF to QCIF (with preliminary
BT.500 training)

018 QCIF from CIF and QVGA DMOS

Attention
019 Stand-alone Attention Model

Objective Measurements: Full Reference
General Difference

020 PSNR dB
Artifact Measurement

Removed Edges 021 Removed Edges Percent
Added Edges 022 Added Edges Percent
Rotated Edges 023 Rotated Edges Percent
% of original deviation from block DC 024 DC Blocking Percent

Artifact Classified (Filtered ) PSNR
Removed Edges 025 Removed Edges Weighted PSNR dB
Added Edges 026 Added Edges Weighted PSNR dB
Rotated Edges 027 Rotated Edges Weighted PSNR dB
% of original deviation from block DC 028 DC Blocking Weighted PSNR dB

Artifact Annoyance Weighted (Filtered ) PSNR
PSNR with default artifact annoyance weights 029 Artifact Annoyance Weighted PSNR dB

Repurposing: Use view model to resample, shift and crop test to map to reference
Format Conversion: Cinema to SD DVD 030 SD DVD from D-Cinema Artifact Weighted

PSNR dB
Format Conversion: SD to CIF 031 CIF from SD Broadcast Artifact Weighted

PSNR dB
Format Conversion: HD to SD 032 SD from HD Broadcast Artifact Weighted

PSNR dB
Format Conversion: CIF to QCIF 033 QCIF from CIF and QVGA Artifact Weighted

PSNR dB
Attention Weighted Objective Measurements

General Difference
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Table 3: Template measurements (cont.)

Measurement Class Measurement Name
PSNR 034 Attention Weighted PSNR dB

Objective Measurements: No Reference
Artifact

DC Blockiness 035 No Reference DC Blockiness Percent
Measurements with Performance Report 1

ADMOS 036 HD ADMOS ITU-BT500 with Interlaced CRT
PQR 037 HD PQR ITU-BT500 with Interlaced CRT
DMOS 038 HD DMOS ITU-BT500 with Interlaced CRT

1 Please refer to the application note Objective Measurements and Subjective Assessment (literature number 28W-24876-0) on the Tektronix
Web site: www.tektronix.com.

Creating New Measurements
You can create measurements by modifying an existing template measurement or by adding a measurement and then
adjusting the necessary parameters in the processing nodes.

To create a new measurement:

1. Click the Measure button.
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2. To create a new measurement
based on a template
measurement, select a numbered
template measurement from the
Measures list and click Edit.

3. To add a new measurement, click
Add.

If you click Add to create a new
measurement, the PQA600 analyzer
displays the Edit Measure window
with only one processing node.
The measurement has no name or
description.
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4. To change the parameters of
your measurement, right-click
on a processing node and
select Configure. Change
the parameters to suit your
requirements.

To add a processing node to
your measurement, select the
desired node at the top of the
window and drag it into the
Process Workflow area.

NOTE. The PSNR and Perceptual
Difference processing nodes are
mutually exclusive. A measurement
cannot contain both nodes.

To remove a processing node
from your measurement,
right-click on the processing
node and select Remove.

5. When you are finished setting
the parameters for your new
measurement, type a name for the
measurement in the Name field.

If you based your measurement
on a template measurement,
the Name field already
has a name in it based on
the template measurement
(Copy of <template name>).
The PQA600 analyzer will
not allow you to replace a
template measurement.

6. If you wish, enter a description
for your measurement in the
Description field.

7. Click OK to save your new
measurement.
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Your new measurement will now
appear at the bottom of the list of
measurements in the Configure
Measure window.

Importing Measures
You can add measures that were created on another PQA600 into your PQA600 by using the Import Measures function. The
Import Measures function works by reading a configuration (.cfg) file, which is the file that contains all measure definitions.
PQA600 measure definitions are saved in a file named Measures.cfg. This file is a binary file and cannot be edited.

NOTE. Importing measures from another PQA600 will not remove the factory defined measures, numbered 001 through
038. Importing measures only adds user-defined measures.

To import a measure from another PQA600:

1. Make a copy of the Measures.cfg
file in the C:\Program Files
(x86)\Tektronix\PQA directory
of the source PQA600 (the
instrument you are importing
from).

NOTE. If the source PQA600 can be
accessed across a network, you can
skip ahead to step 3.
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2. Copy the copied Measures.cfg file
into a directory on the PQA600 on
which you want to add the measure
(the destination instrument).

3. Select File > Import Measures.
This displays the Import Measures
Configuration dialog box.

4. Click Browse. This opens a dialog
you can use to select the .cfg file
you want to import.

5. Select the .cfg file that contains
the measure you want to import
and click Open.

6. Select how you want the user
defined measures to be imported.

Select Append to existing
measures to add measures to
your machine without replacing
measures you have already
created,

Select Replace existing user
defined measures with new
measures to replace all the
user-defined measures in your
instrument with the user-defined
measures in the imported .cfg file.
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7. Click Import to load the new
measures.

8. Click Close to remove the Import
Measure dialog or click Configure
Measure to display the Configure
Measure window.

Changing Measurement Parameters
You change the parameters of a measurement by adjusting the configuration nodes for the measurement. To access the
configuration nodes of a measurement, select Edit from the Configure Measure window.

You change the parameters in a configuration node by right-clicking on the configuration node and selecting Configure from
the pop-up menu.
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The following table lists the configuration nodes and the parameters they control. Some of these nodes are not included in
every measurement. Two of the nodes (PSNR and Perceptual Difference) are mutually exclusive.

Table 4: Measurement configuration nodes
Node Parameters controlled by this node
Display Model Display technology: CRT, LCD, or DMD. Each technology has user-configurable

parameters (Interlace/Progressive, Gamma, Response time, and more). Reference
Display and Test Display can be set independently.

View Model Viewing distance, Ambient Luminance for Reference and Test (can be set
independently), image cropping and registration: automatic or manual control of image
cropping and test image contrast (ac gain), brightness (dc offset), horizontal and
vertical scale and shift.

PSNR There are no parameters for PSNR. You can only choose whether or not the PSNR
result is included as part of the measurement.

Perceptual Difference The viewer characteristics (acuity, sensitivity to changes in average brightness,
response speed to the moving object, sensitivity to photosensitive epilepsy triggers,
and more).

Attention Model Overall attention weighting for measures as well as for each class of attention attractor:

Temporal (motion).

Spatial (center, people (skin), foreground, contrast, color, shape, size).

Distractions (differences).
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Table 4: Measurement configuration nodes (cont.)

Node Parameters controlled by this node
Artifact Detect Added Edges (Blurring), Removed Edges (Ringing/Mosquito Noise), Rotated Edges

(Edge Blockiness) and DC Blockiness (Removed detail within a block)
Summary Node Statistical Units (PSNR, Perceptual Difference, Blockiness). Measure Map settings:

Gain, Offset, display as signed data. Worst Case Training for ITU-R BT.500 Training
(Default or User application tuned: Determined via Worst Case).

Display Model
To change the display model parameters:

1. Click the Measure button.

2. Select the desired measurement
from the Configure Measure
window.

NOTE. If you choose a template
measurement, you will have to save
the changed measurement under a
new name.

3. Click Edit.

PQA600 Quick Start User Manual 23



Operating Your Instrument

4. Right-click on Display Model and
select Configure.

5. Adjust the parameters of the
display model as necessary.

To change the application setting,
select the Technology first. This
defines the choices available for
application.

You can customize display properties
to better suit your requirements by
setting Application to Custom then
editing the display properties.

6. Set the Application setting to
Custom.

7. Type a name for your custom
settings in the Custom field
or select a previously created
configuration file from the
drop-down list.

8. Click Edit to display the Edit
Custom window.
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The Edit Custom window contains
two groups of settings: Display
Properties and CRT/DMD/LCD
Properties. The settings in
the Display Properties group
are the same for every display
technology, though the values for
the settings differ. The settings
in the CRT/DMD/LCD Properties
group change depending on
the selected technology. The
illustrations to the right show the
difference in the properties for an
LCD display and a DMD (Digital
Micro-mirror Device) display.

9. Edit the settings as necessary to
suit your requirements.

Click Restore Defaults to return
all settings to the initial factory
values.

Click Undo Changes to return all
settings to the previously saved
values.

10. When you have completed making
your changes, click OK to save
your changes.

LCD display properties

DMD display properties

The following table lists the parameters that can be set in the Display Model configuration node. For details on these
parameters, see the PQA600 Picture Quality Analyzer Technical Reference, Tektronix part number 071-2778-XX.
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NOTE. If the Display Model Technology parameter is set to CRT and the CRT scan method is set to Interlaced, the PQA600
expects the source video file to have a “Top Field First” format.

Table 5: Display model parameters
Parameter Setting
Apply To: Reference

Test
Both Reference and Test

Optimize for Accuracy
Speed

Technology CRT / DMD / LCD
Application

Display Properties Maximum Luminance (cd/m2 = nits)
Brightness (%Max Luminance)
Equivalent Gamma
Contrast (%)
Aspect Ratio

LCD Properties Horizontal Resolution (pixels)
Vertical Resolution (lines)
Gray levels
Contrast Ratio
Response Time (ms)

DMD Properties Horizontal Resolution (pixels)
Vertical Resolution (lines)
Gray levels

View Model
The View Model specifies the conditions under which the display viewed and, optionally, performs spatial alignment,
cropping, gain, and DC offset adjustment to match the test video to the reference video. You can set values such as the
viewing distance and ambient luminance level.

To change the view model parameters:

1. Click the Measure button.
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2. Select the desired measurement
from the Configure Measure
window.

NOTE. If you choose a template
measurement, you will have to save
the changed measurement under a
new name.

3. Click Edit.

4. Right-click on View Model and
select Configure.
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5. Edit the settings as necessary to
suit your requirements. Note that
all cropping and shift values of the
test are in reference pixel units
(use post scale values). Also,
offset brightness is in units input
to the view model. For example,
if the output of a display model is
input, the units are nits (candelas
per square meter) while if video is
directly input, the units are LSBs.

Click Restore Defaults to
return all settings to the initial
factory values.

6. When you have completed making
your changes, click OK to save
your changes.

The following table lists the parameters that can be set in the View Model configuration node. For details on these
parameters, see the PQA600 Picture Quality Analyzer Technical Reference, Tektronix part number 071-2778-XX.

Table 6: View model parameters
Parameter Setting
Reference Viewing Distance (Screen Heights)

Ambient Luminance (cd/m2)
Test Match Reference

Independent of Reference
Viewing Distance (Screen Heights)
Ambient Luminance (cd/m2)

Optimize For: Accuracy
Speed

Default Spatial Alignment – Reference Crop (pixels and lines)
Default Spatial Alignment – Test Horizontal

Vertical
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Table 6: View model parameters (cont.)

Parameter Setting
Crop (pixels and lines)
Luma Gain and Offset

Changing the Spatial Alignment. You may need to change the spatial alignment between your test and reference video
files to accommodate changes in the test file due to processing. Video files must be spatially aligned to get meaningful results.

Perceptual Difference
The Perceptual Difference node includes the human vision model for quantifying perceptual sensitivities to the video tested,
including differences (including artifacts from codecs, noise or any visible difference of any kind) optionally relative to a
reference, changes in perception due to changes in displays, viewing distances, and more. The output of this node is a
Perceptual Difference Map in units of percent perceptual contrast. The Perceptual Difference node allows you to adjust
parameters for viewer characteristics (such as acuity, sensitivity to changes in average brightness, response speed to the
moving object, sensitivity to photosensitive epilepsy triggers, and more).

To change the Perceptual Difference parameters:

1. Click the Measure button.

2. Select the desired measurement
from the Configure Measure
window.

NOTE. If you choose a template
measurement, you will have to save
the changed measurement under a
new name.

3. Click Edit.
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4. Right-click on Perceptual
Difference and select Configure.

5. Edit the settings as necessary to
suit your requirements.

If the Typical or Expert viewer does
not meet your needs, you can specify
the parameters for a custom viewer.
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6. Click Custom.

7. Type a name for the custom
viewer parameters in the Custom
field or select a previously
created configuration file from the
drop-down list.

8. Click Edit to display the Edit
Perception Viewer window.

9. Edit the settings as necessary to
suit your requirements.

Click Restore Defaults to return
all settings to the initial factory
values.

Click Undo Changes to return all
settings to the previously saved
values.

10. When you have completed making
your changes, click OK to save
your changes.

The following table describes the parameters that can be set in the Perceptual Difference configuration node. For details on
these parameters, see the PQA600 Picture Quality Analyzer Technical Reference, Tektronix part number 071-2778-XX.

Table 7: Perceptual difference parameters
Parameter Setting
Acuity Minimum Acuity: 0 (legally blind) to 1 (perfect, super-human acuity). This parameter

controls the acuity (center spatial frequency response) in the darkest areas of the image.
Lum. Sensitivity: 0 (in-human, no adaptation) to 1.0 (hyper-sensitive). This parameter
controls how the local acuity increases with increases in local average luminance.
Area Adaptation: 0 (the entire visible area) to 1.0 (smallest resolved area). This
parameter controls (surround spatial frequency) how large an area is integrated to
determine the local luminance used for the local luminance sensitivity adaptation. Larger
values make adaptation to luminance more localized.
Adapt. Lum. Sens.: 0 (in-human, no adaptation) to 1.0 (hyper-sensitive). This parameter
controls the (surround spatial frequency) luminance sensitivity to the area integration
adaptation. Large values accelerate the localization of the acuity adaptation to luminance.
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Table 7: Perceptual difference parameters (cont.)

Parameter Setting
Variance Sens.: 0 (non-human: no adaptation) to 1.0 (hyper-sensitive). This parameter
controls how the acuity changes from a stimulus of threshold contrast to supra-threshold
contrast. Higher values correspond to bigger differences in acuity for low contrast versus
high contrast stimuli.

Speed Minimum Speed: 0 (extremely slow) to 1.0 (instant response / zero response time). This
parameter controls the speed of visual response in darkness.
Lum. Sensitivity: 0 (always as slow as in darkness) to 1.0 (fast even for slightly lighter
than darkness). This parameter controls how much response time decreases with
increase in average local luminance.
Adaptation Speed: 0 (virtually no speed adaptation to local luminance) to 1.0
(instantaneous speed adaptation to local luminance). This parameter controls how
quickly response time changes to local luminance.
Adapt. Lum. Sens.: This parameter controls temporal integration used for determining
the local luminance value to which speed adapts. Use 0 for static and 1.0 for extreme
photosensitive epilepsy.
Variance Sens.: 0 (non-human: no adaptation) to 1.0 (hyper-sensitive). This parameter
controls how the response speed changes from a stimulus of threshold contrast to
supra-threshold contrast. Higher values correspond to bigger differences in response
speed for low contrast versus high contrast stimuli.

Masking Noise Masking: This parameter sets the baseline threshold of perception (1 JND) for
the highest sensitivities.
Local Lum. Sensitivity: This parameter sets sensitivity to changes in luminance (for
example, between reference and test).
Local Lum. Mask: This parameter controls how much luminance masks (or simple
Weber’s Law) verses other masking.
Local Similarity: This parameter controls how much masking is due to local image
pattern similarities.
Sim Localization: This parameter specifies the localization of similarity masking. For
example, 0 is used for no localization and 1 is used for 100% localization of masking
due to local similarity.
Variance Masking: Conceptually, this is a local complexity masking control.
Area Threshold: Approximately, this parameter controls the support region area for
variance masking by clipping regions below a threshold.
Area Integration: This parameter controls the localization of variance masking: use 0 for
no localization and use 1 for 100% localization.

Overall Sensitivity Gain: This parameter sets the overall sensitivity.

PSNR
The PSNR configuration node does not contain any parameters. The node is present so that the PSNR result can be
added to a measurement. Note that PSNR and Perceptual Difference results are mutually exclusive. A measurement can
include either PSNR or Perceptual Difference, but not both.

32 PQA600 Quick Start User Manual



Operating Your Instrument

Artifact Detection
The Artifact Detection configuration node allows you to specify parameters that control the measurement of spatial artifacts.
There are two mutually exclusive artifact detection measurements that can be performed at any one time:

Spatial Gradient Artifacts

DC Blockiness Artifacts

The chosen measurement can be used to weight any upstream measurement result via a cross-fade between the input
result map and a 100% artifact weighted result via the "Overall Artifact Weighting" control. A setting of 0 corresponds to
making artifact detection transparent (as if the node did not exist in the processing chain), while a setting of 100% gives
full artifact weighting. Full artifact weighting filters the previous map, for example PSNR or perceptual contrast such that
areas with no artifact are 0 and areas with 100% artifact are passed unchanged.

Spatial Gradient Artifacts. The three classes of spatial gradient-related artifacts measured are:

reduction in gradient magnitude at each point (% Lost Edges, usually associated with blurring).

increase in gradient magnitude at each point (% added edges, usually associated with ringing, mosquito noise and
similar artifacts).

rotated gradient orientations (% rotated edges, usually associated with blocking).

The weighting for Lost, Added Edges and Rotated Edges is relative: the total is internally normalized to 100%. Note
however, that measurement values for added and lost edges are complimentary: if 100% lost edges are measured, zero
added measures will measured.

The Produce complimentary data setting produces a one’s compliment of the normalized-to-one result map before being
applied to the input result map, if any. If this setting is chosen, areas without the enabled artifacts are bright in the results map
and a perfect (no detected artifact) result is 100% when no upstream node is present, or no change for PNSR, DMOS, etc.

DC Blockiness Artifacts. This measurement attempts to find a blocking grid structure and then, for full reference (dual
ended) measurements, measures the difference between each pixel and the mean value within the block in which the pixel
resides, normalized by the corresponding difference in the reference video. If all pixel values are equal to the block mean in
the test, but corresponding pixels in the reference are not equal to the block mean, the measurement result is 100% DC
Blockiness.

Notice that the denominator can be zero. In this case, the contributing pixel term is zero. Thus, perfect images may have
less than 100% results. For example, flat (no detail) areas of the image that occupy a block will all be zero. However, for
video, artifact free video will measure very close to 100%.

To configure the Artifact Detection parameters:

1. Click the Measure button.
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2. Select the desired measurement
from the Configure Measure
window.

NOTE. If you choose a template
measurement, you will have to save
the changed measurement under a
new name.

3. Click Edit.

4. Right-click on Artifact Detection
in the Process Workflow area and
select Configure.
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5. Edit the settings as necessary to
suit your requirements.

Select or deselect the Enable
checkbox to determine
whether or not the associated
artifact is detected in the
measurement.

Adjust the value next to each
artifact type to specify how
much importance is given to
the associated artifact.

6. When you have completed making
your changes, click OK to save
your changes.

The following table lists the parameters that can be set in the Artifact Detection configuration node. For details on these
parameters, see the PQA600 Picture Quality Analyzer Technical Reference, Tektronix part number 071-2778-XX.

Table 8: Artifact detection parameters
Parameter Setting
Spatial Gradient Artifacts % Lost Edges (Blurring)

% Added Edges (Ringing)
% Rotated Edges (Blocking)
Produce complimentary data

DC Blockiness Artifacts % DC Blockiness
Overall Artifact Weighting Range: 0–100

Attention Model
The Attention Model configuration node allows you to specify how attention is measured and the weighting for selected
characteristics.

To configure the Attention parameters:

1. Click the Measure button.
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2. Select the desired measurement
from the Configure Measure
window.

NOTE. If you choose a template
measurement, you will have to save
the changed measurement under a
new name.

3. Click Edit.

4. Right-click on Attention Model
and select Configure.
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5. Edit the settings as necessary to
suit your requirements.

PQA600 Quick Start User Manual 37



Operating Your Instrument

If the Typical configuration does
not meet your needs, you can
specify the parameters to specify
a custom attention model.

6. Click Custom.

7. Type a name for the custom
attention model parameters in the
Custom field or select a previously
created configuration file from the
drop-down list.

8. Click Edit to display the Edit
Attention window.

9. Edit the settings as necessary to
suit your requirements.

Select or deselect the
checkbox next a setting
to determine whether or not
the setting is included in the
measurement.

Click Restore Defaults to return
all settings to the initial factory
values.

Click Undo Changes to return
all settings to the previously
saved values.

10. When you have completed making
your changes, click OK to save
your changes.

The following table lists the parameters that can be set in the Attention Model configuration node. For details on these
parameters, see the PQA600 Picture Quality Analyzer Technical Reference, Tektronix part number 071-2778-XX.

Table 9: Attention model parameters
Parameter Setting
Feature Weights Motion
Spatial Weights Center
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Table 9: Attention model parameters (cont.)

Parameter Setting
People
Foreground
Contrast
Color
Shape
Size

Distraction Weights Differences: Weights distractions outside the probable focus of
attention. Distractions include artifacts, large differences between
reference and test, or other things that might make someone look
at an area normally not of interest in program material.

Summary Node
The Summary Node specifies how results are reported. You can specify statistical units for measurements, whether or not
results are saved and how they are saved, display characteristics of the map, and levels for warnings and errors.

1. Click the Measure button.

2. Select the desired measurement
from the Configure Measure
window.

NOTE. If you choose a template
measurement, you will have to save
the changed measurement under a
new name.

3. Click Edit.
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4. Right-click on Summary Node
and select Configure.

5. Edit the settings as necessary to
suit your requirements.
Note that the PSNR and
Perceptual Difference settings
are mutually exclusive. Only one
setting will be accessible at a time.

6. When you have completed making
your changes, click OK to save
your changes.

The following table describes the parameters that can be set in the Summary Node configuration node.

Table 10: Summary node parameters
Parameter Setting Description
PSNR Map Units Sets PSNR results units to map units. Only selectable

when measuring PSNR.
dB Units Sets PSNR results units to dB. Only selectable when

measuring PSNR. The reference level is 235.
Perceptual Difference Perceptual Contrast Sets the units used in the graph display to Perceptual

Contrast when the Perceptual Difference node is part of
the measurement.
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Table 10: Summary node parameters (cont.)

Parameter Setting Description
DMOS Units Sets the units used in the graph display to DMOS Units

when the Perceptual Difference node is part of the
measurement.

PQR Units Sets the units used in the graph display to PQR Units
when the Perceptual Difference node is part of the
measurement.

Artifacts Percent Max Artifact Sets the units used in the graph display to Percent
Max Artifact when the Artifact Detection node is part
of the measurement. For example, if the artifact
detection selected is DC Blockiness, an output of 100%
corresponds to the entire image block being a constant
("DC") value, whereas 0% corresponds to no change
from the reference.

dB Units Sets the units used in the graph display to dB Units when
the Artifact Detection node is part of the measurement.

Save Results None When selected, no measure map or measurement values
are saved to disk when the measurement is completed.

Maps & Values When selected, both the measure map and measurement
values are saved to disk when the measurement
is completed. The map and results filenames are
incremented by one (file1, file2, file3, etc.), for each
subsequent run of the measurement.

Map Overwrite When selected, both the measure map and measurement
values are saved to disk when the measurement is
completed. The map and results files are overwritten for
all subsequent runs of the measurement.

Values Only When selected, only measurement values are saved to
disk when the measurement is completed. The results
filename is incremented by one (file1, file2, file3, etc.), for
each subsequent run of the measurement.

Value Overwrite When selected, only measurement values are saved to
disk when the measurement is completed. The results file
is overwritten for all subsequent runs of the measurement.

Measure Map Display Gain Change to adjust the brightness level of the results map.
This is useful when optimum contrast for the test and
reference video is different from that of the results map.

Offset Change to shift the baseline of the results map. This
parameter can be used in combination with Gain to
enhance relatively minor differences in the measure map.
This is useful when the optimum reference and test video
brightness setting on the display are different from the
optimum brightness setting for the results map.
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Table 10: Summary node parameters (cont.)

Parameter Setting Description
Display as Signed Data When this option is not selected, results map pixels

have intensity proportional to the absolute value of the
measurement being made. So for example, for PSNR,
brighter pixels correspond to larger differences, both
positive and negative differences, between the test and
reference. However, when this option is selected, the
sign is retained at each pixel so that with a positive offset
(see Measure Map Display Offset above) is added, no
difference is gray, with positive differences being brighter
and negative differences being darker.

Event Log Warning Level Sets the green-to-yellow transition point on the indicator
bar in the Graph portion of the display.

Error Level Sets the yellow-to-red transition point on the indicator bar
in the Graph portion of the display.

ITU-T BT.500 Worst
Case Training Sequence
Response

Import Normally this button is selected to calibrate a given DMOS
measurement. First, the DMOS measurement is run with
worst case video, then the measurement is edited, this
"Import" button is pressed and the DMOS results selected,
thereby importing the Minkowski metric of the perceptual
contrast difference (which represents the training result).

Video File Formats Supported for Measurements
The PQA600 recognizes the following file formats for taking measurements. All formats are 8-bits resolution except .v210
and .vcap10 files. Measurements on the .v210 and .vcap10 file formats are made only on the 8 most significant bits.

Supported Video Formats
File format File extension Frame structure options
CbYCrY (601-4:2:2), UYVY .yuv Non-Interlaced, Field 1 First, Field 2 First, Planar
YCbYCr (4:2:2), YUY2 .yuv Non-Interlaced, Field 1 First, Field 2 First, Planar
YCbCr 4:2:0 .yuv Planar only
CbYCrY 4:2:2 (601-4:2:2),
UYVY (10bit)

v210 Non-Interlaced

YUV 4:4:4 .yuv Non-Interlaced, Field 1 First, Field 2 First, Planar
BGR .rgb Non-Interlaced, Field 1 First, Field 2 First, Planar
ARIB YUV .yyy, .rrr, .bbb Not applicable
AVI (Uncompressed UYVY,
YUY2, RGB, RGB32, v210)

.avi Not applicable

Vcap 8-bit (Captured by
optional SDI card.)

.vcap Not applicable

Vcap 10-bit (Captured by
optional SDI card.)

.vcap10 Not applicable
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When you select a file format that is headerless (yuv or rgb), the PQA600 will prompt you to specify the file format (width,
height, frame rate, frame structure, and format).

Figure 1: File format dialog box

Use the following guidelines for specifying the file format:

If the selected file is in interlaced format and the line construction matches #1 in the following figure, select “Field 1
First” for Frame Structure.

If the selected file is in interlaced format and the line construction matches #2, select “Field 2 First” for Frame Structure.

If the selected file is interlaced scanning and it has a de-interlaced format like #3, select “No_Interlace”.

If the selected file has the progressive scanning like #4, select “No_Interlace”.

If the selected file has the 4:2:0 planar format like #5, select “No_Interlace” and “YCbCr 4:2:0 (Planar Only)” at
Sample format selection.

The interlaced video content is supposed to be “Top field first”.

PQA600 Quick Start User Manual 43



Operating Your Instrument

44 PQA600 Quick Start User Manual



Operating Your Instrument

Taking a Measurement
To take a measurement:

1. Click the Measure button.

2. Select a Measure from the
Measures list.

3. In the Reference box, click
Browse.
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4. Select the reference file to be used
for the measurement.

5. In the Set Reference File
Format dialog, enter the values
appropriate for the file.

6. Click OK.

7. In the Test box, click Browse.
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8. Select the test file to be used for
the measurement.

9. In the Set Test File Format dialog,
enter the values appropriate for
the file.

10. Click OK.
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You might need to adjust the temporal
and spatial alignments. If you know
the reference and test sequences are
aligned temporally and spatially, you
don’t need to perform any alignment
procedure before continuing with
the measurement. If the spatial
alignment parameters of the View
Node for the selected measurement
are properly configured, you don’t
need to adjust the spatial alignment
settings before proceeding, though
you will need to temporally align the
files. If you do not know that the
test and reference files are aligned,
you must align the files temporally
and spatially before proceeding with
the measurement.(See page 49,
Performing Temporal Synchronization
and Spatial Alignment of Sequences.)

11. Click OK in the Configure Measure
window.

12. Click the Measure button to start
the measurement.
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Keep the following points in mind when taking a measurement:

When .rgb or AVI_RGB format files are used for the reference or test video sequence, the PQA600 converts to files to
the YUV format internally (with a CCIR 601 color matrix) before starting the measurement.

When the measurement has Display Model node is set to Interlaced CRT, the PQA600 expects the file video format
is "Top Field First".

Performing Temporal Synchronization and Spatial Alignment of Sequences
For the PQA600 to take valid measurements, the reference and test video sequences must be temporally synchronized and
spatially aligned. There are two tabs on the Configure Measure window that are used to synchronize and align sequences:
the Temporal Sync tab and the Spatial Alignment tab.

Figure 2: Temporal Sync tab
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Figure 3: Spatial Alignment tab

Temporal Sync
Use the Temporal Sync tab to match the starting and ending frames of the reference and test video sequences. You can
synchronize video sequence either manually or automatically. In manual mode, you specify the start and end frames of the
sequences. In automatic mode, the PQA600 compares a range of frames in the test sequence to the start frame of the
reference sequence to synchronize the video sequences.

Manual Temporal Alignment. In a Manual Temporal Sync, you manually adjust the starting frames of the reference and
test sequences until they are aligned, using a PSNR map for guidance. To perform a Manual Temporal Alignment, you will
start by specifying the From frame for the reference and test sequences. You will then adjust the From frame for the test
sequence. Using a PSNR map that indicates differences in the selected frames, you will adjust the test sequence frame until
the PSNR map indicates a minimum of differences between the selected frames.
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To temporally synchronize the reference and test sequences manually:

1. With the Measures dialog box
displayed, click the Temporal
Sync tab.
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2. To set the starting frame of the
reference sequence, adjust the
top slider on the Reference
Sequence bar. If needed, you
can use the number entry box to
change the starting frame one
frame at a time.

NOTE. To view the sequence by time
rather than by frame, select Seconds
in the Units section.

As you adjust the slider, the image
in the Reference window changes
to show the selected frame.
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3. To set the starting frame of the test
sequence, adjust the top slider on
the Test Sequence bar. If needed,
you can use the number entry box
to change the starting frame one
frame at a time.
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Once video sequences have been
specified on the Measure tab, the
PQA600 displays a PSNR map
in the Results Map frame. You
can use this map to align the two
video sequences. Adjust the test
sequence to achieve the darkest
possible PSNR map (black is
best). On the PSNR map, any
differences between the reference
start frame and the test start
frame will be highlighted. The
illustration at the top-right shows
how a difference of two frames
appear in the PSNR map. The
illustration below it shows how the
PSNR map appears when the two
sequences are aligned.
The PSNR map shows both
temporal and spatial alignment.
Thus, you might also have to use
the Horizontal and Vertical Shift
settings on the Spatial Alignment
tab to properly align the reference
and test sequences.

PSNR map with frames temporally unaligned

PSNR map with frames temporally aligned
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Automatic temporal alignment. In an Automatic Temporal Sync, the PQA600 compares a range of frames of the
reference and test sequences and adjusts the starting frame of the test sequence until alignment is achieved (if possible). As
with the manual temporal alignment, you must specify the From frame for both the reference and test sequences. Then
you must specify a range of frames to use for comparison.

The range of frames compared is specified by setting values for the Search Delay. The Search Delay is specified in seconds.
For example, if the frame rate is 30 frames per second, specifying a search delay of 1 second will result in 30 frames being
compared. The Search Delay setting has two elements: From and To.

When performing a automatic temporal alignment, the PQA600 is attempting to determine the offset between frames in the
reference and test sequences which are temporally aligned. You control the search range by setting the values for Search
Delay From and Search Delay To.

To illustrate how the values for From and To interact, assume the following: the frame rate is 30 Hz, the Reference From
frame is 30, and the Test From frame is 50.

Example 1: When Search Delay From is set to -1 and Search Delay To is set to 0, the PQA600 will compare Reference
frames 30–60 against Test frame 50 to achieve temporal synchronization. See the following figure.

Example 2: When Search Delay From is set to 0 and Search Delay To is set to 1, the PQA600 will compare Reference
frame 30 against Test frames 50–80 to achieve temporal synchronization. See the following figure.

PQA600 Quick Start User Manual 55



Operating Your Instrument

Example 3: When Search Delay From is set to -1 and Search Delay To is set to 1, the PQA600 will compare Reference
frames 30–60 against Test frames 50–80 to achieve temporal synchronization. See the following figure.
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When performing an automatic temporal alignment, keep the following in mind:

You can select any start frame for the reference and test sequences. Alignment does not have to begin with the first frame.

In some cases, when test sequence is badly distorted, you may get a warning the PQA600 is not able to align perfectly.
However, the auto alignment function still provide the best possible match.

If test sequence has frozen or skipped frames, the PQA600 might display a warning that the offset (difference between
aligned frames) is not constant for the entire sequence. The reference and test frames on the Temporal Sync tab will
be set according to measured initial offset.

The more frames that are compared to determine temporal alignment, the more time will be used. If you have an idea
of the location where the sequences will align, you can set the From values in the Reference and Test Sequences
and the Search Delay to minimize the time spent searching for aligned frames. For example, if you think that frame
100 in the reference sequence will align with frame 150 in the test sequence, you can set the From values to 90 and
140, respectively, and the Search Delay values to -1 and 1, respectively, to minimize the time spent aligning the
sequences rather than setting the From values to 1 and the Search Delay values to -6 and 6 and then waiting for the
software locate the aligned frames.

To temporally synchronize the reference and test sequences automatically:

1. With the Measures dialog box
displayed, click the Temporal
Sync tab.
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2. Click the Automatic option button
under Temporal Alignment.

3. To set the starting frame of the
reference sequence, adjust the
top slider on the Reference
Sequence bar. If needed, you
can use the number entry box to
change the starting frame one
frame at a time.

NOTE. To view the sequence by time
rather than by frame, select Seconds
in the Units section.

4. To set the starting frame of the test
sequence, adjust the top slider on
the Test Sequence bar.
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5. To specify the frames of the
reference sequence used for
comparison, enter a value for the
Search Delay From parameter.

6. To specify the frames of the test
sequence used for comparison,
enter a value for the Search Delay
To parameter.

7. To start the automatic temporal
alignment process, click Apply.

The figure at the right shows the
automatic temporal alignment process
running. When the process completes,
the From values for reference and test
sequences will match (if a matching
frame in the test sequence was found
within the search range).

Spatial Alignment
Use the Spatial Alignment tab to match areas of the reference and test sequences that are compared. You can spatially
align the reference and test sequences either manually or automatically. The reference and test sequences must be
spatially aligned to achieve meaningful measurement results.

To spatially align the reference and test sequences manually:
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1. Click the Spatial Alignment tab.

2. To manually crop the reference
sequence, enter a number into
the Left, Right, Top, and Bottom
boxes in the Reference section.

NOTE. As you adjust the values for
cropping, the values for Cropped will
change
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If the resolution of the test
sequence does not match the
resolution of the reference
sequence, you must scale the test
sequence. For example, if the
reference sequence is 640 x 480
and the test sequence is 1280
x 720, you must scale the test
sequence so that the scaled value
is equal to 640 x 480.

3. To scale the test sequence, adjust
the values in the Scale number
entry boxes for both horizontal and
vertical values.

4. If the reference and test sequences
do not align vertically, adjust the
Shift(px) values so that the test
sequence matches the reference
sequence.
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5. If you have to shift the test
sequence to align it with the
reference sequence, you might
need to crop the test sequence
(remember the PSNR map will
highlight any differences between
the sequences).
Crop the test sequence by
adjusting the Left, Right, Top, and
Bottom boxes in the Test section.

6. If you need to adjust the luminance
of the test sequence to match the
reference sequence, adjust the
Luma values Gain and Offset
Brightness in the Test section.

NOTE. If the selected Measure
contains a View Model node, this
Luma setting is overridden by the
values in the View Model node.

7. After you make the spatial
alignment adjustments, click OK.

You can allow the PQA600 to spatially align the reference and test sequences.
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To spatially align the reference and test sequences automatically:

1. Click the Spatial Alignment tab.

2. To automatically crop the
reference sequence, select Auto
in the Reference section.
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3. To automatically scale the test
sequence, select Auto for both the
Horizontal and Vertical settings.

The PQA600 will compare up to
±30% of the test sequence horizontal
and vertical pixels to the reference
sequence searching for alignment.

4. To automatically crop the test
sequence to match the reference
sequence, select Auto for the
Crop (px) setting.
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5. To adjust the Luma of the test
sequence, enter values for the
Gain and Offset parameters.

NOTE. If the selected Measure
contains a View Model node, this
Luma setting is overridden by the
values in the View Model node.

6. After you select Auto for the
adjustments you need to make,
click OK to automatically align the
reference and test sequences.

Tips
If you receive a low correlation warning message after running the automatic temporal or spatial alignment, expand
the Auto Search Delay or Auto Search Range and run the alignment again.

Auto alignment works best when the video sequences contains moving objects. Try to select a portion of the video
sequences that contain a moving object if you will be using auto alignment.

If the video sequence contains scenes that pan and zoom, the automatic temporal / spatial alignment process might
have difficulty achieving alignment. You might have to use automatic alignment repeatedly or use manual alignment
to properly align the sequences.

If you are measuring the sequences with different frame rate, ensure that the start frame for the reference and test
sequences align on exactly the same start frame. Any phase offset difference between the start frames will result in
poor measurements.

If you are measuring sequences that are part of a 3:2 pull-down process (for example, the reference is 23.98p and the
test is 59.94i with the 3:2 pull-down process), the start frames for reference and test must be aligned with the first
frame in a 3:2 sequence.

The Gain and Offset settings on the Spatial Alignments tab are manual only. If you want to use automatic Gain and
Offset compensation, you must edit the View node of the measurement and enable the Auto option for Gain and Offset.
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Using the Region-of-Interest
Region-of-Interest Basics
Region-of-Interest (ROI) is a feature that limits measurements to a region of a video sequence that is used for measurements.
An ROI can be applied before a measurement is taken, which is named an Input ROI; or an ROI can be applied after
measurements are taken, which is named an Output ROI. An Input ROI is used to exclude portions of the video sequence
from being used in a measurement. The Output ROI is used to limit the calculation of measurement results to a specific
region, which can make it easier to determine the source of impairments.

An Input ROI is applied to the reference and test video sequences prior to any other processing and the region outside an
Input ROI is excluded from the alignment or measurement. An Output ROI is applied to the measurement result and the
overall score can be recalculated for the specified region.

You can specify ROI in spatial terms (an area within a frame), or in temporal terms (which frames to include within a
measurement). Spatial ROI defines the region of interest by specifying the pixels contained within the region of interest. A
Spatial ROI is the same for all frames within a video clip. A Temporal ROI defines the region of interest by specifying the
frames contained within the region of interest. It is these specified frames, in the case of an Output Temporal ROI, that
are used to calculate the Overall measurement value. For example, if the test sequence is 1000 frames long, you could
specify an Output Temporal ROI to limit measurements to frames 200 through 800.

An Output Spatial ROI is a rectangular region within the result map. The overall score can be recalculated for a subregion
even after measurement is run.

ROI Examples
One use for an Input Spatial ROI is to specify portions of the reference video sequence to ignore when taking a measurement,
which would improve the measurement accuracy. If you were using a 16x9 video sequence as the reference sequence, and
a 4x3 video sequence as the test test sequence (A in the following figure), you would need to specify the Input Spatial ROI
settings to limit the portion of the reference sequence used for measurements to a 4x3 area (B in the following figure), that
results in a reference sequence ROI that aligns with the test video sequence (C in the following figure).
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Another example of how to use an Input Spatial ROI is to exclude a portions of sequences which do not match from being
compared. For example, if the test sequence contains a caption that does not appear in the reference sequence, you can
specify an Input Spatial ROI to limit measurements to the regions of the two sequences that match. The following illustration
shows how an Input Spatial ROI would be applied in this situation, A represents the reference sequence. B represents the
test sequence, which contains a caption that does not appear in the reference sequence. To ensure a valid measurement,
you would specify an Input Spatial ROI that limits the region of the reference sequence and the test sequence that is used for
measurements. C shows how the ROI applies to the reference sequence. D shows the portion of the test sequence that is
not included in the comparison with the reference sequence.
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Specifying an ROI
To specify an ROI, you use the ROI tab of the Configure Measure window.

To specify ROIs using the ROI tab in the Configure Measure dialog:

1. Click the Measure button.
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2. Select the measurement you wish
to run and specify the Reference
and Test files as required.

3. Select the ROI tab.
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4. Enter values for the Input Spatial
ROI (both Reference and Test)
and the Output Spatial ROI
parameters.

5. To configure the Output Temporal
ROI, specify the range of frames to
which you wish to limit the Overall
measurement.

NOTE. When the measurement
is run, the measurement will be
calculated for all the frames specified
on the Temporal Sync tab. The frames
specified on the ROI tab are only the
frames used to calculate the Overall
measurement value.

6. Click OK to save your
measurement selections.

7. Click the Measure button to begin
the measurement.
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Generating and Capturing Video (Requires Option SDI)
The PQA600, with Option SDI installed, can generate SDI video signals using a file as a source. The PQA600 can also
capture video signals to a file for later review and analysis.

Simultaneous Generation and Capture
The PQA600 can generate and capture video on two channels simultaneously. Using this capability, you can generate a
video signal, route that signal to a device-under-test, and then route the device-under-test output back into the PQA600 for
analysis. When used in this way, the video formats must match. Both the generation and capture capabilities can be used
independently. The two-channel capture and generate capability can be configured to generate two channels simultaneously,
capture two channels simultaneously, or generate one channel and capture one channel simultaneously.

The PQA600 enables you to swap the two output channels so that you can view either output even if you have only a single
monitor. The ability to simultaneously generate two outputs can be used to perform subjective picture quality evaluation that
complements the PQA600 objective measurements. The ability to simultaneously capture two channels enables you to
capture both the reference and test signal simultaneously, which can be useful in broadcast operations.

Supported Source Video File Formats
The PQA600 requires a video file as a source to generate a video signal. The PQA600 supports the following file formats.
All formats are 8-bits resolution.

Supported video formats for generation
File format File extension Frame structure options
CbYCrY (601-4:2:2), UYVY .yuv Non-Interlaced, Field 1 First, Field 2 First, Inverted
YCbYCr (4:2:2), YUY2 .yuv Non-Interlaced, Field 1 First, Field 2 First, Inverted
BGR .rgb Non-Interlaced, Field 1 First, Field 2 First, Inverted
CbYCrY (601-4:2:2), UYVY
(10-bit)

.v210 Non-Interlaced

AVI (Uncompressed UYVY,
YUY2, RGB, RGB32, v210)

.avi Not applicable

Vcap (Captured by optional
SDI card.)

.vcap Not applicable

Vcap 10-bit (Captured by
optional SDI card.)

vcap10 Not applicable

When you select a file format that is headerless (yuv or rgb), the PQA600 will prompt you to specify the file format (Width,
Height, frame rate, frame structure, and format). Use the following guidelines for specifying the file format.

If the selected file is in interlaced format and the line construction matches #1 in the following figure, select "Field 1
First" for Frame Structure.

If the selected file is in interlaced format and the line construction matches #2, select "Field 2 First" for Frame Structure.

If the selected file is interlaced and it has a noninterlaced format like #3, select “No_Interlace”.

If the selected file has progressive scanning like #4, select “No_Interlace”.
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NOTE. If the selected file is in AVI format, the PQA600 converts the file to a raw file format (yuv, vcap10, or rgb) before
beginning generation (the filename extension indicates the format). After the conversion is completed, the file format dialog
appears and asks you to confirm the file format before starting the generation.

NOTE. If the yuv file or the converted data from an rgb file selected for generation contains values of "0" or "255",in the
output data these values are replaced by"1" or "254", respectively, due to the SDI standard requirements.

The interlaced video content is supposed to be "Top field first".

The following table lists the resolution and start lines for each output format.

Resolution and start lines for each format
Format Resolution Start Lines
525i 720 x 486 F1-21/F2-20 (On generation, the second line in the file

is F2-20 and the F1-263 is a copy line of F2-262) (On
capture, the topmost line in the captured file is a copy line
of F2-20 and the bottommost line in the captured file is
F2-262).

625i 720 x 576 F1–23 / F2–23
720p 1280 x 720 F1–26
1080i 1920 x 1080 F1–21 / F2–21
1080p 1920 x 1080 F1–42
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Supported SDI Video Formats
The PQA600 can generate and capture the SD and HD SDI video formats listed in the following table.

Supported video formats
Format Frame Rates
SD-SDI 525i/59.94

625i/50
720p/50, 720p/59.94, 720p/60
1080i/50, 1080i/59.94, 1080i/60

HD-SDI

1080psF/23.98, 1080psF/24, 1080p/23.98 1080p/24,
1080p/25, 1080p/29.97, 1080p/30

Synchronizing to an External Reference
You can synchronize video generation or capture with the PQA600 internal clock or an external bi-level or tri-level sync signal.
If you use an external clock, you must connect the bi-level or tri-level sync reference to two pins on the SDI Interface Card DVI
connector. Connect the Reference – signal to pin 19. Connect the Reference + signal to pin 20. Refer to the following figure.

Generating Video Output
If you have Option SDI installed in your instrument, you can generate a video output signal using a video file as a source. To
connect an external device-under-test to the instrument, use the SDI cable supplied with your instrument.

SDI cable
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Connecting Signals to the SDI Video Interface Card
Connect the PQA600 analyzer SDI video interface card as follows:

1. Connect one of the BNC
connectors on the SDI cable
to the device-under-test.

2. Connect the appropriate SDI OUT
mini-connector to the OUT 2/B
connector on the video generation
card.

The PQA600 analyzer is now ready to signal to the device under test.

Generating a Video Output Signal
To generate an output signal:

1. Click the Sdi Capture/Generate
button.
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2. Select the format for the generated
signal from the Format drop-down
list.

3. Select the appropriate Clock
Selection. If you need to
synchronize the video output
with an external system, select
External Reference, otherwise,
select Internal Reference.

4. Select the channel you will use
to generate your signal by setting
Channel 1 Mode to Generate to
Output1.

5. Click the Browse button and
locate the source file to be used.
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6. The instrument will prompt you to
enter parameters for video format.
Enter the appropriate Width,
Height, Frame Rate, Frame
Structure, and Format for the file
you have selected.

Set File Format dialog for YUV file formats

7. Using the From box, set the
starting frame number. Use the
To: box to specify the ending
frame number.

Use the current frame slider
control to quickly locate the area
where the video signal should
begin.

Use the Current Frame box to
specify exact frame where you
want to video signal to start.
You can copy the number in the
Current Frame box to the From
box to set the video generation
start frame. This operation also
works for the To box.

8. Select the loop button if you
want the video generation to loop
continuously.

9. Click the Play button to begin the
signal generation.

10. If you have configured the
instrument to capture video when
Play begins, a dialog box will
remind you that the instrument is
set up to capture video when play
begins. Click OK to continue.
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The figure on the right shows an
example of video signal generation
running in loop mode.

Swapping Output Channels
If you are generating two outputs simultaneously, you can swap the output channels so that Channel 1 is output on Channel 2
and Channel 2 is output on Channel 1. This enables you to view both generated outputs even if you have only one monitor
available. Use the Swap OUT1↔OUT2 button to swap the output channels. The following illustration shows the location of
the Swap OUT1↔OUT2 button. The button appears only when both channels are set to generate a signal.
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To swap the output channels:

1. Click and hold the Swap OUT1↔OUT2 button. As long as you hold the Swap OUT1↔OUT2 button down, the two
channel outputs are swapped.

Swap OUT1↔OUT2 when held down

2. To return the channels to their original output, release the mouse button so you are no longer holding down the Swap
OUT1↔OUT2 button.

Capturing Video
If your instrument has Option SDI installed, you can capture two SDI video signals to files for analysis. To connect your video
source to the PQA600 analyzer, use the SDI cable supplied with the PQA600 analyzer.

SDI cable

Connecting Signals to the Video Capture Card
Connect your video source to the PQA600 analyzer video capture card as follows:
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1. Connect one of the SDI IN BNC
connectors on the SDI cable to the
video source.

2. Connect the appropriate SDI IN
mini-connectors to the IN 1/A or
IN 2/B connectors on the video
capture card.

The PQA600 analyzer is now ready to capture video to a file.

Capturing Video to a File
To capture video to disk:

1. Click the Capture button.
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2. Select the format of the input video
signal from the drop-down list.

NOTE. If you are capturing video
generated by the PQA600, the format
selected here must match the format
of the generated video.

3. Specify which channel you will
use to capture your input signal
by setting Channel 2 Mode to
Capture from Input2.

NOTE. You can set either Channel 1
or Channel 2 to capture a signal. You
can also set both channels to capture
a signal simultaneously.

4. Specify the name of the file that
the video should be captured to
using the Capture To entry box.
Use the Browse button to select a
location from a dialog box.

5. Set the Save as Type to either
VCAP (8-bit format) or VCAP10
(10-bit format).

6. Set the Start Capture method.

Select Manual if you want to
begin a capture when you
select Rec.
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Select With Ch1 to capture video
when you are generating a signal
with the PQA600. If you want to
insert a delay between the time
the signal generation starts and
the time the capturing starts, enter
a value in the second(s) box.

7. Set the Stop Capture method.

Select Manual if you want to
stop capture when you select
Stop.

Select Duration if you want to
capture video of a specified
duration. If you select
Duration, enter the length
of time you want to capture
video.

Select With Ch1 to stop
capturing video automatically
when the PQA600 stops
generating a signal (based on
the Generate settings).
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8. To begin the capture:

If you specified Manual for the
Start Capture method, click
Rec.

If you selected With Play,
capture begins automatically
when you select the play
button on the GENERATE side
of the window.

9. To stop the capture:

If you specified Manual for the
Stop Capture method, click
Stop when you have captured
enough video.

If you selected Duration for
the Stop Capture method,
capture will stop when the
Time Elapsed equals the
duration that you specified.

If you selected With Play as the
stop capture method, capture
stops when the Play cycle
completes (assuming Play is
not set to Loop).

Converting Video Files
Many programs cannot use the VCAP files generated by the PQA600. To use VCAP files with other programs, the
PQA600 includes a DOS command line program, TekFileConverter.exe, that converts AVI or VCAP files to RGB, YUV, or
V210 file format. The format to which the files are converted depends on the format within the source AVI or VCAP file.
For example, if the source AVI file contains video data in RGB format, the converter program converts the AVI file to a
RGB format file (video data only, no audio data). If the AVI file contains video data in YUV format, the converter program
converts the AVI file to a YUV format file (video data only, no audio data). If the source file is in VCAP format (8-bit), the
converter program converts the VCAP file to a YUV format file. If the source file is in VCAP10 format (10-bit), the converter
program converts the VCAP10 file to a V210 format file.

How output files are named. The output file is named according to the source file name and the video
format contained in the file. For example, suppose you capture a video signal with the PQA600 that is saved as
tutorial.vcap. The format of the file is encoded within the file structure. The file converter program uses
that internal data to name the converted file. Thus, the output of the file converter using tutorial.vcap might be
tutorial_1920X1080_2997fps_NoInterlace_CbYCrY.yuv.

To convert an AVI or VCAP file:
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1. Display a Command Prompt window (Start > All Programs > Accessories > Command Prompt).

2. In the Command Prompt window, change directories to the directory that contains the file you want to convert.

3. Type the following: TekFileConverter.exe filename where filename is the name of the file you want
to convert. Press the Enter key.

After the file converter starts, it displays its progress: Converted XX of XXXX frames....

When the conversion is complete, the converter displays the name of the converted file:

The converted file is — tutorial_1920X1080_2997fps_NoInterlace_CbYCrY.yuv

Reviewing Measurement Results
Once you have taken a measurement, you can view the measurement results in several ways. The PQA600 analyzer has
four display views that allow you to inspect video clips, analyze measurement data, or compare video clips and results.

The Summary View display allows you to simultaneously review each frame of the reference clip, test clip, and the map
with a graph of the selected measurement

The Tile view allows you to view the reference file, test file, and map simultaneously.

The Event Log displays points in the test clip where measurements exceed specified levels.

The Overlay view allows you to display two views (one on top of the other) to compare variations between the two views.

Where Measurement Results Are Saved
Measurement results are saved in the folder that contains the test file. The results files are saved in a folder named after the
test file with “-Results” appended to the file name. For example, the PQA600 analyzer includes a sample file named
V031051_Stripy_jogger_1280x720p_3mbs.yuv. If you run measurements on this file, all measurement results will be saved
in a folder named “V031051_Stripy_jogger_1280x720p_3mbs-Results”, which will be located in the same
folder as the V031051_Stripy_jogger_1280x720p_3mbs.yuv file.

NOTE. Do not move the reference and test files once you have run a measurement. The measurement results file points to
the location of the reference and test files and displays those files when you review the measurement results. If you move the
reference and test files after running a measurement, the PQA600 will not be able to find the files in their new location.
If you must move the reference and test files, you must edit the measurement results file to point to the new location of
the reference and test files.

Selecting Measurement Results for Display
You select measurement results for display from the Results Navigation pane. To select results from the Navigation pane,
you must first add directories to the Navigation pane.

To add directories to the Navigation pane:
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1. Select Working Directories from
the File menu.

2. From the Edit Working
Directories dialog, select Add.

3. From the Browse For Folder
dialog, navigate to the folder that
contains your test video clips.

4. Select the folder that contains the
test video clips and click OK.
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When the Edit Working Directories
dialog is displayed, you can see the
directory you just added now appears
in the list of Working Directories.

5. In the Edit Working Directories
dialog box, click OK.

6. In the main application window,
click the Review button.

7. Click the + symbol next to the
folder for the directory you just
added to the working directory list.
The results located in the selected
directory will appear when you
click the + symbol.

The Summary View Display
The Summary View display consists of four tiles that show the reference clip, the test clip, the map, and a graph.

1. To show the Summary View
Display, click the Summary View
button.
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This is how the Summary View
display appears in Current view
with no measurement running.

This is how the Summary View
display appears when ready to
begin a measurement.

The Reference video clip
appears in the upper-left tile.

The Test video clip appears in
the upper-right tile.

The graph of the primary
measurement appears in the
lower-left tile.

The impairment map appears
in the lower-right tile.
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This is the Summary View display in
Review mode.

Controls appear above the
tiles that you can use to select
which frame is displayed.

A readout appears at the
bottom-right corner of
the window that shows
the Minimum, Maximum,
and Average values of the
primary measurement (the
measurement that is shown in
the graph).

The yellow line in the graph
indicates the currently
displayed frame.

Table 11: Elements of the control bar
Control Description

The control bar controls replay of the video
clips.

The frame selector allows you to choose
which frame of the video clip is displayed.
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Table 11: Elements of the control bar (cont.)

Control Description
The Units selector allows you to specify the
displayed frame by frame number or time.

Selecting SDI Out outputs the Test file on
the Ch 2 and outputs the Reference file on
Ch 1. This enables you to view the Test
and Reference files on a standard monitor
independent of the PQA600 display. This
function is only available when the format
of the Reference and Test files is the same
and supported by the SDI card. Click the
SDI Capture / Generation button to play the
review contents in real time. The application
converts avi file to raw file format (yuv, rgb
or v210) when it is selected for Reference
or Test.

The Tile View Display
The Tile View enables you to view the reference, test, and map at normal size, in a vertical arrangement. Each tile acts like a
window view of the video clip or map. You drag the clip within the window to focus on a particular portion of the clip. You can
also resize the tiles by dragging the bars that separate the tiles.

1. To display the Tile View Display,
click the Tile View button.

This is the Tile View display in
Review mode. The Tile View
cannot be displayed in Current
mode.

The Reference clip appears
in the top tile. The Test clip
appears in the middle tile. The
map appears in the bottom tile.

You can play the video clip in
the Tile View using the control
bar and frame selector at the
top of the window.
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2. You can change which portion of
the video clip appears in the tile
by clicking and dragging the video
clip in the tile. The same frame
number is used for all three tiles,
but you can view different portions
of the frame in each tile. You can
also enlarge or shrink the tiles by
dragging the bars that separate
the tiles.
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3. You can compare two
measurement results in the
Tile View. To do this, use the Ctrl
key to select two results files in the
Navigation pane and then select
the Tile View button.
For example, you could compare
an Attention Weighted PSNR
measurement to a DMOS
measurement.

NOTE. In the control bar that there is
a lock icon. The lock icon indicates
whether the two frame selectors are
tied together. If the lock is closed,
the frame selectors are tied together
and changing one selector changes

the other. If the lock is open, ,
then you change either frame selector
without changing the other.

NOTE. Having the frame selectors
locked does not require that they be
set to the same frame number. Each
frame selector can be set to a different
frame number.

The Error Log Display
The Error Log display contains entries that identify events when the Error and Warning levels have been exceeded. The
measurement that is shown in the Error Log depends on the selected measurement. You set the values for Error and
Warning levels in the Summary configuration node.
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To display the Error Log Display,
click the Tile View button.

The Error Log is a listing of all the
events that exceed the Warning
and Error levels as specified in the
Summary Node for the selected
measurement. The Error Log is
only a listing, there are no controls
associated with the Error Log
display.

The following paragraph shows a subset of lines from an error log. Line numbers are added here for the sake of discussion;
the line numbers do not appear in an actual error log.

1. 05/24/2010 15:50:38 - Measure: 034 Attention Weighted PSNR dB

2. 05/24/2010 15:50:38 - Reference File: f:Vclips\1280x720p\V031051_Stripy_jog-

ger_1280x720p.yuv

3. 05/24/2010 15:50:38 - Test File: f:Vclips\1280x720p\V031051_Stripy_jog-

ger_1280x720p_3mbs.yuv

4. 05/24/2010 15:50:42 - Warning: Begin Limit Warning - Measurement value of

25.937963 at frame 1.0 exceeds warning threshold of 45.00.
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5. 05/24/2010 15:50:42 - Error: Begin Limit Violation - Measurement value of

25.937963 at frame 1.0 exceeds error threshold of 30.00.

6. 05/24/2010 15:57:11 - End Limit Violation - Frame: 165.0 Duration: 164.0.

Every line begins with the date and time of the error log entry. Line 1 identifies the measurement selected. Lines 2 and
3 identify the path and name of the reference and test files, respectively. Line 4 identifies an event where the PSNR
exceeded the warning level. The line lists the measurement value, the frame number where the event occurred and the
level that was violated (the warning threshold of 45.00). Line 5 lists another event, in this case the Error level was violated.
Line 6 shows that the limit violations have ended. The violation end point is identified by frame number and the duration of
the violation is also listed.

The Overlay View Display
The Overlay View allows you to compare the reference and test video clips or a video clip (reference or test) and a map by
stacking one on top of the other. You can shift the mix of video clip or map from 0% to 100%, with the default mix set at 50%
of each. You can use the Overlay View to easily match features in a video clip with features in an map.

To display the Overlay View
Display, click the Overlay View
button.

The Overlay View defaults to a
50/50 mix which is indicated by the
slider at the bottom of the Overlay
View display.

To select which two sources are
compared, use the R/T/M check
boxes next to the view buttons.

Select R to chose the
Reference clip. Select T
to choose the Test clip. Select
M to choose the map.
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This example view compares the
Test video clip with the map. The
mix in this view is 50% test clip
and 50% map. The ratio of the mix
is shown by the numbers at the
bottom right and bottom left of the
Overlay view.
At the top of the Overlay view are
readouts of the source file name
assigned to each side of the slider.
In this example, moving the slider
to the right will increase the mix
in favor of the map (filename.csv)
and moving it to the left increases
the mix in favor of the test clip
(filename.yuv).

The Graph Display
The Graph display plots several measurement values against frame number. The particular measurements shown in
the Graph display depend on the selected measurement.

To display the Graph display:

Select either the Tile View or Summary View.

This is the Graph display in Review
mode.

The graph of measurements
(relevant to the selected
measurement) are plotted
versus frame number shown at the
top of the graph.
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Right-click on the Graph to display the
Graph pop-up menu. You can adjust
the display of the graph using the
commands:

Expand the horizontal scale of
the graph by selecting Horizontal
Zoom In.

Expand the vertical scale of the
graph by selecting Vertical Zoom
In.

Select Zoom In or Zoom Out to
resize the graph as desired.

To reset the graph to its original
scale, select Zoom Fit.

This illustration shows the appearance
of the graph after selecting Zoom In.

To change the Graph display
properties, select Show Plot Setup.
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To select additional statistics for
the selected measurement, select
the statistics you wish to display
by checking the box next to the
measurement.

To change the appearance of a plot
line:

1. Select the measurement.

2. Click on the Change Color box
and select a color.

3. Select a line from the Change
Trace box to use a different line for
the measurement.
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This illustration shows a Graph display
with all available measurements
displayed.

You can easily compare the results of two measurements by plotting both measurements on the Graph display at the
same time.

1. To add existing results to the
current Graph view, locate the
measurement you want to add in
the Working directory pane and
control-click on the result.
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The measurement result you selected
will be added to the current graph.

Using Output Region-of-Interest to Review Results
Output Spatial ROI. To specify the region of interest, you draw a box over the region in the video in which you are
interested and then update the measurements. The measurement result is then recalculated for the region you have selected.

To specify an Output Spatial ROI in Review mode:

1. Set up and run a measurement on
the video clip of interest.
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2. Select a frame which you can use
to select the region of interest.
The region of interest that you
specify will be applied to each
frame in the test clip.

NOTE. Note that the Configure button
is highlighted and the Update Graphs
button is not selectable.

3. Shift-click and drag over the region
of the Results Map that you wish
to limit the measure to (if you do
not use Shift, you will just drag the
video clip within the window).

As you start to drag the pointer over
the region of interest, a box will appear
on the Results Map that displays the
location of the pointer.
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Note that as you click and drag,
the selection box is drawn over the
Reference video, Test video, and
Results Map at the same time.
Once you have specified the region of
interest, the Update Graphs button is
selectable.

4. To evaluate the measurement only
for the region of interest, click the
Update Graphs button.

The measurement result in the
graph area is updated to reflect the
measurement limited to the region of
interest. Both the graph and the bar
readout change to reflect the new
measurement results.

PQA600 Quick Start User Manual 99



Operating Your Instrument

This screen shows the result of
selecting a region of interest that has
a lower DMOS result.

Output Temporal ROI. To specify an Output Temporal ROI, you select the frames of the video clip you wish to analyze.
After you specify the frames to which you want to limit your measurement, the measurement results are updated immediately.

A typical use for Temporal ROI is when you wish to analyze a portion of a concatenated test clip.

To specify an Output Temporal ROI:

1. Set up and run a measurement on
the video clip of interest.

NOTE. After the measurement is
complete, look at the measurement
results in the lower-right corner of the
window. Note the value for Overall.
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2. Adjust the gray triangles above the
plot in the Graph display to select
the frames to which you wish to
limit the measurement.

The measurement results are updated
immediately after you specify the
frames used in the measurement. You
do not have to initiate an update to the
results.
Compare the Overall measurement
result in the lower-right corner of the
window with the value you saw before
you limited the frames used in the
measurement. In this example, the
Overall value for the whole video clip
is 57.084. But the Overall value after
specifying the Temporal ROI is 65.692.
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PSNR Measurement
PSNR Measurement shows the difference between the reference sequences and test sequences by subtracting them. It
does not take into account the human vision model, so the result shows the absolute difference between the reference and
test sequences. PSNR is useful for identifying small errors that the human can not recognize. The highlighted white areas
of a PSNR map show the areas of greatest difference between the original and degraded image. This measurement is
useful at the beginning of the CODEC debugging process.

The PQA600 analyzer provides PSNR results for overall sequence and each frame. It also provides the PSNR map that is
used to find the location where there are differences. The brightness and contrast for the PSNR map can be controlled from
the Configure > Display Settings dialog. By adjusting the brightness and contrast you can make it easier to find differences
on the PSNR map when it appears there is little difference between the reference and test sequences.

1. Click the Measure button.

2. Select the 020 PSNRdB
measurement from the Configure
Measure window.

3. In the Reference box, click
Browse.
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4. In the Open dialog box,
browse to the directory:
F:\Vclips\1280x720p.

5. Select the file
V031051_Stripy_jog-
ger_1280x720p.yuv and click
Open.

6. In the Set Reference File Format
dialog, enter the following values:

Width: 1280

Height: 720

Frame Rate: 30

Sample Format: YCbCr 4:2:0
(Planar Only)

7. Click OK.
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8. In the Test box, click Browse.

9. Select the file
V031051_Stripy_jog-
ger_1280x720p_3mbs.yuv
and click Open.
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10. In the Set Test File Format dialog,
enter the following values:

Width: 1280

Height: 720

Frame Rate: 30

Sample Format: YCbCr 4:2:0
(Planar Only)

11. Click OK.

12. Click OK in the Configure Measure
dialog box.
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13. Click the Measure button to begin
the measurement.

When the measurement is complete,
the progress bar will display Measure
Complete and display the elapsed
time the measurement required.

14. To view the results of the
measurement, click the Review
button.
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When you select the Review view,
the existing display will change
to the one shown at the right. To
review results, you select them
from the Navigation pane. To
select a results file for review,
the directory that contains the
results file must be selectable in
the Navigation panel. Since there
are no directories currently in the
navigation pane, we will add them.

15. To add directory containing
measurement results to the
navigation pane, select File >
Working Directories.

16. From the Edit Working Directories
dialog, select Add.
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17. From the Browse For Folder
dialog, navigate to the folder that
contains the video clips you tested.

18. Select the folder that contains the
video clips and click OK.

When the Edit Working Directories
dialog is displayed, you can see
the directory just added now
appears in the list of Working
Directories.

19. In the Edit Working Directories
dialog box, click OK.

20. Click the + symbol next to the
folder for the directory you just
added to the working directory list.
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21. Click the + symbol next to the
folder named after the test file you
selected.
When the folder expands, you will
see results files for all the tests you
have run using the test video clip.

22. Select the results file labeled
020 PSNR dB.csv.

23. To review the results, adjust the
slider bar to change the displayed
frame. Note which frame has
the worst value, and note the
highlighted region on the map.
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DMOS Measurement
The DMOS (Differential Mean Opinion Score) measurement shows the difference between the reference and test sequences
taking the human vision model into consideration under ITU-R BT.500 conditions. This measurement predicts the degree
to which viewers perceive the difference between reference and test sequences (under the ITU-R BT.500 conditions).
This measurement is useful for evaluating the general performance of CODEC algorithms / instruments. The perceptual
difference map shows the location in the sequence where there are differences that can be perceived by people. The DMOS
measurement is useful for identifying what sequence and CODEC algorithm combination impacts picture quality.

1. Click the Measure button.

2. Select the 006 HD Broadcast
DMOS measurement from the
Configure Measure window.

3. In the Reference box, click
Browse.
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4. In the Open dialog box,
browse to the directory:
C:\Video\PreInstalled_
Sequence\Vclips\1280x720p.

5. Select the file
V031051_Stripy_jog-
ger_1280x720p.yuv and click
Open.

6. In the Set Reference File Format
dialog, enter the following values:

Width: 1280

Height: 720

Frame Rate: 30

Sample Format: YCbCr 4:2:0
(Planar Only)

7. Click OK.
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8. In the Test box, click Browse.

9. Select the file
V031051_Stripy_jog-
ger_1280x720p_3mbs.yuv
and click Open.
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10. In the Set Test File Format dialog,
enter the following values:

Width: 1280

Height: 720

Frame Rate: 30

Sample Format: YCbCr 4:2:0
(Planar Only)

11. Click OK.

12. Click OK in the Configure Measure
dialog box.
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13. Click the Measure button to begin
the measurement.

When the measurement is
complete, the progress bar will
display Measure Complete and
display the elapsed time the
measurement required.
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14. To view the results of the
measurement, click the Review
button.
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If you performed the previous
application, PSNR Measurement,
you will see that the results for
this measurement now appear
above the previous results. (If
the results do not appear in the
Navigation panel, select File >
Update Sequence List.)

15. To review the measurement
results, click the 006 HD
Broadcast DMOS.csv results file.

16. To review the results, adjust the
slider bar to change the displayed
frame. Note the different pattern in
the results compared to the PSNR
measurement.
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Artifact Weighted DMOS Measurement
Blurring, Ringing/Mosquito Noise, and Blockiness are well known artifacts caused by CODEC processing. It can be useful to
a designer to know individual DMOS scores for each type of artifact. The artifact-weighted DMOS measurement provides the
DMOS score for each artifact type and thus, indicating to the CODEC designer ways to optimize the algorithm.

For example, if the result from the DMOS score and the Blurring weighted DMOS score are similar, it means the DMOS
result was mainly caused by Blurring.

1. Click the Measure button.

2. Select the 006 HD Broadcast
DMOS measurement from the
Configure Measure window.

3. In the Reference box, click
Browse.
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4. In the Open dialog box,
browse to the directory:
C:\Video\PreInstalled_
Sequence\Vclips\1280x720p.

5. Select the file
V031051_Stripy_jog-
ger_1280x720p.yuv and click
Open.

6. In the Set Reference File Format
dialog, enter the following values:

Width: 1280

Height: 720

Frame Rate: 30

Sample Format: YCbCr 4:2:0
(Planar Only)

7. Click OK.
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8. In the Test box, click Browse.

9. Select the file
V031051_Stripy_jog-
ger_1280x720p_3mbs.yuv
and click Open.
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10. In the Set Test File Format dialog,
enter the following values:

Width: 1280

Height: 720

Frame Rate: 30

Sample Format: YCbCr 4:2:0
(Planar Only)

11. Click OK.

12. Click OK in the Configure Measure
dialog box.
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13. Click the Measure button to begin
the measurement.

When the measurement is
complete, the progress bar will
display Measure Complete and
display the elapsed time the
measurement required.

14. To view the results of the
measurement, click the Review
button.
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15. In the main application window,
click the Review button.
If you performed the one of
the previous applications, you
will see that the results for this
measurement now appears with
the previous results. (If the results
do not appear in the Navigation
panel, select File > Update
Sequence List.)
If you have not performed any
of the previous measurements,
you will need to add the directory
containing the measurement
results to the Navigation
pane. (See page 83, Selecting
Measurement Results for Display.)

16. Click the + symbol next to the
F:\VClips\1280x720p folder.

17. Click the + symbol next to the
V031051_Stripy_jogger_
1280x720p_3mbs-Results.
When the folder expands, you will
see results files for all the tests you
have run using the test video clip.

18. Click on the results file labeled 006
HD Broadcast DMOS.csv.

If you get a similar artifact DMOS result as you do with the DMOS measurement, it means that the majority of the DMOS
result is due to artifacts measured by the artifact DMOS measurement. Thus, you might be able to improve the DMOS result
by altering your algorithm to reduce the artifacts measured by the artifact DMOS measurement.
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Attention Weighted DMOS Measurement
The attention weighted DMOS measurement provides a DMOS result with weighting apportioned by probable areas in the
sequences on which the human eye is focusing. This measurement provides information that enables a designer to optimize
a CODEC for a specific application, such as a Sports program. Knowing which areas of sequences get the most attention
from viewers enables the designer allocate to bit resources for the more important objects in the scene.

1. Click the Measure button.

2. Select the 013 HD Sports
Broadcast ADMOS measurement
from the Configure Measure
window.

3. In the Reference box, click
Browse.
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4. In the Open dialog box,
browse to the directory:
F:\VClips\1280x720p.

5. Select the file
V031051_Stripy_jog-
ger_1280x720p.yuv and click
Open.

6. In the Set Reference File Format
dialog, enter the following values:

Width: 1280

Height: 720

Frame Rate: 30

Sample Format: YCbCr 4:2:0
(Planar Only)

7. Click OK.
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8. In the Test box, click Browse.

9. Select the file
V031051_Stripy_jog-
ger_1280x720p_3mbs.yuv
and click Open.
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10. In the Set Test File Format dialog,
enter the following values:

Width: 1280

Height: 720

Frame Rate: 30

Sample Format: YCbCr 4:2:0
(Planar Only)

11. Click OK.

12. Click OK in the Configure Measure
dialog box.
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13. Click the Measure button to begin
the measurement.

When the measurement is
complete, the progress bar will
display Measure Complete and
display the elapsed time the
measurement required.
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14. In the main application window,
click the Review button.
If you performed the one of
the previous applications, you
will see that the results for this
measurement now appears with
the previous results. (If the results
do not appear in the Navigation
panel, select File > Update
Sequence List.)
If you have not performed any
of the previous measurements,
you will need to add the directory
containing the measurement
results to the Navigation
pane. (See page 83, Selecting
Measurement Results for Display.)

15. Click the + symbol next to the
folder for the directory you just
added to the working directory list.

16. Click the + symbol next to the
folder named after the test file you
selected.
When the folder expands, you will
see results files for all the tests you
have run using the test video clip.

17. Select the results file labeled
013 HD Sports Broadcast
ADMOS.csv.

If you see a different trend for the DMOS result, it means the contents contains an area which attracts higher attention from
the viewer. You might consider optimizing the algorithm in ways to reduce human eye attention.
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Artifacts Measurement with No Reference
An artifacts measurement with reference provides a more accurate picture quality measurement (with respect to human
perception) than an artifact measurement with no reference. The reason for this is that the measurement system cannot
determine if the artifacts in the picture are caused intentionally by the creator or by unexpected system behavior. Nonetheless,
an artifacts measurement with no reference is still a valuable measurement tool. An artifact measurement with no reference
will measure well-known digital compression artifacts in a picture sequence. This measurement is useful for monitoring a
broadcast system where there is no expectation of a reference sequence as there would be in a camera evaluation.

Artifact detection reports a variety of different changes to the edges of an image:

Lost Edges or Blurring

Added Edges or Ringing/Mosquito Noise

Rotated Edges (Vertical and Horizontal) or Edge Blockiness

Loss of Edges Within an Image Block or DC Blockiness

The No Reference DC Blockiness Percent measurement measures artifacts in a sequence and is used when there is no
reference sequence. This measurement is useful for sample monitoring of a broadcast.

1. Click the Measure button.

2. Select the 035 No Reference
DC Blockiness Percent
measurement from the Configure
Measure window.

3. In the Test box, click Browse.
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4. In the Open dialog box,
browse to the directory:
F:\Vclips\1280x720p.

5. Select the file
V031051_Stripy_jog-
ger_1280x720p_3mbs.yuv
and click Open.

6. In the Set Test File Format dialog,
enter the following values:

Width: 1280

Height: 720

Frame Rate: 30

Sample Format: YCbCr 4:2:0
(Planar Only)

7. Click OK.
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8. Click OK in the Configure Measure
dialog box.

9. Click the Measure button to begin
the measurement.
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When the measurement is
complete, the progress bar will
display Measure Complete and
display the elapsed time the
measurement required.

10. In the main application window,
click the Review button.
If you performed the one of
the previous applications, you
will see that the results for this
measurement now appears with
the previous results. (If the results
do not appear in the Navigation
panel, select File > Update
Sequence List.)
If you have not performed any
of the previous measurements,
you will need to add the directory
containing the measurement
results to the Navigation
pane. (See page 83, Selecting
Measurement Results for Display.)

11. Click the + symbol next to the
F:\Vclips\1280x720p folder.
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12. Click the + symbol next to the
V031051_Stripy_jogger_
1280x720p_3mmbs-Results.
When the folder expands, you will
see results files for all the tests you
have run using the test video clip.

13. Click on the results file labeled 035
No Reference DC Blockiness
Percent.csv.

14. To view the Event Log for the

measurement, click on (the
Event Log button).
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Automated Measurements Using XML Scripting
Using the PQA600 analyzer XML scripting capability, you can also run multiple measurement sequences simultaneously.
You do this by running the software from a command line. When run in this way, the normal Windows application interface is
not launched, but you will get a status readout in the command prompt while the measurement is running. Using the XML
scripting capability maximizes system performance when you need to perform multiple measurements.

There are two ways to create an XML script. The simplest way is to export a measurement to a script from the Configure
Measure window. Alternatively, you can edit an XML script file to specify the measurement to be made, the reference and
test files, and any other parameters necessary to execute the test.

Exporting an XML Script
To export an XML script:

1. Click the Measure button.
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2. Configure a measure as you want
to run it.
Select a measure and specify
all measurement characteristics
(when you are not using a
predefined measure). Specify
the Reference and Test files as
required.
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3. Select the Show Import/Export
Setting check box.
This displays two additional text
entry boxes. One text entry box is
used to specify a script to import
and the other text entry box is
used to specify the file name of an
exported script.
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4. Type in a path and file name for
your exported script or click the
Browse button to specify where to
save your script file.

5. Click Save to save the measure to
the script file.
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Importing an XML Script
To import an XML script:

1. Click the Measure button.

2. Select the Show Import/Export
Setting check box.
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This displays two additional text
entry boxes. One text entry box is
used to specify a script to import
and the other text entry box is
used to specify the file name of an
exported script.
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3. Type in a path and file name for
your imported script or click the
Browse button to use the Open
dialog to select the script file to
import.

4. If you use the Browse button, click
Open in the Open dialog box to
open the selected script file.
When you click Open, the PQA600
imports the script and configures
the Measure as defined in the
script file. This includes the
selected measure, Temporal Sync
tab settings, Spatial Alignment tab
settings, ROI tab settings, and the
reference and the test files.

5. If you typed in a path and file name
for the script, click Open to import
the script file.
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6. Once the script is imported, click
OK to accept the script settings.
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Running a Script
To run a script, open a command prompt window, change directories to the PQA600 application directory, and type “PQxml
filename”. The measurement begins and the results are saved in the same location as they would be if the measurement
were run through the regular PQA600 Windows application.

There are two sample XML script files installed with the PQA600 application (they are located in the PQA600 application
folder). The sample scripts are NestedXmlFileCreatingCsvReportFile.xml and ExampleListOfMeasurementsToMake.xml.

To run an XML script:

1. Open a command prompt window
by selecting Start > All Programs
> Accessories > Command
Prompt.

2. Change directories to the PQA600
application directory.

To execute a script file, you enter
the name of the script application
(PQXML) followed by the name of
the script. Scripts can be located on
other drives than the C: drive, as the
following example shows.

3. Type PQXML followed by the script
name.

For example:

PQXML F:HD_DMOS_Mea-

surementSettlings.xml

142 PQA600 Quick Start User Manual



Applications

While the XML script is running, the
application will display its progress.

4. When the measurement is
complete, you can open the
results file with the PQA600
application or with a spreadsheet.
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DMOS Measurement with SDI Generation, Capture, and Auto Temporal/Spatial
Alignment

You can use the PQA600 with Option SDI to capture video for analysis. Furthermore, you can generate an SDI video signal
to serve as the video source for a Device-Under-Test. You connect SD/HD SDI video output and input to the video interface
card on the rear panel. Captured video files have a .vcap file extension. The following procedure demonstrates the process
of generating and capturing video. This procedure demonstrates the whole process from selecting a file to use as a source
for generating video, capturing the video from a device-under-test, to measuring the DMOS.

NOTE. The PQA600 saves video capture files with a VCAP file extension.

1. Connect the SDI interface
card Out 2/B connector to the
device-under-test input connector.

2. Connect the device-under-test
output connector to the SDI
interface card 1/A connector.

3. Click the Sdi Generate / Capture
button. This displays the
Simultaneous Generate and
Capture window.
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4. Set the format for the generated
signal from the Format drop-down
list. Select HD-SDI: 1080i/59.94
(sF 29.97).

5. Click the Browse button.
Navigate to F:\Preinstalled_Se-
quences\Vclips\1920x1080. Se-
lect the file V031051_Stripy_jog-
ger_1920x1080i_UYVY.yuv and
click Open.
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6. Set the file format as follows:

Height: 1920

Height: 1080

Frame Rate: 29.97

Frame Structure: No Interlace.

Sample Format: CbYCrY
(601–422)

7. Specify the name of the file that
the video should be captured to
using the Capture To entry box.
Use the Browse button to select
a location from a dialog box. Set
the capture file to F:\Tutorial and
click Save. The file name appears
in the Capture To box.

8. Set Start Capture to With Ch1.

9. Set Stop Capture to With Ch1.

10. Click the play button to start
generating a video signal and
capturing the output of the
device-under-test.

11. Because Start Capture is set to
With Play, a dialog box will remind
you that the instrument is set up to
capture video when play begins.
Click OK to continue.

146 PQA600 Quick Start User Manual



Applications

The figure at the right shows video
capture in progress.

12. When the capture is completed,
click Close.

PQA600 Quick Start User Manual 147



Applications

13. Click the Configure Measure
button at the bottom-right corner
of the Simultaneous Generate and
Capture window.

14. Select the 006 HD Broadcast
DMOS measure.

15. Click the Browse button for
Reference and navigate to
F:\Vclips\1920x1080. Select
the file V031051_Stripy_jog-
ger_1920x1080i_UYVY.yuv and
click Open.

16. Set the file format as follows:

Height: 1920

Height: 1080

Frame Rate: 29.97

Frame Structure: No Interlace.

Sample Format: CbYCrY
(601–422)

148 PQA600 Quick Start User Manual



Applications

17. Click the Browse button for Test
and navigate to F:\. Select the file
Tutorial.vcap and click Open.

18. Click the Temporal Sync tab.

19. Click Automatic in the Temporal
Alignment section, then click
Apply.

Once you click Apply, the PQA600
attempts to align the video sequences
automatically.
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20. When the Temporal Alignment
is complete, click the Spatial
Alignment tab.

21. Select Auto on all parameters,
Click OK.

22. Click Measure.
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When the PQA600 first starts the
measurement, it will first perform a
spatial alignment if the settings are on
Auto. While it does this, the panels
in the Summary View will be black.
The status of the alignment process
is displayed in the status bar at the
lower-left corner of the application
window.
Once the alignment phase is complete,
the measurement phase begins.

On occasion you might receive a Temporal Alignment Warning after the PQA600 attempts to align two video sequences.

This can occur for a number of
reasons. A low correlation coefficient
can occur because two sequences
are out of the range of alignment, you
are analyzing flat field sequences,
or because of distortions in the test
sequence.

If you receive this warning, you might be able to improve the correlation between the sequences by changing the temporal
alignment settings (if the cause of the low correlation coefficient is poor alignment). For detailed information on adjusting
the temporal alignment settings, see the PQA600 Picture Quality Analysis System Measurement Technical Reference,
part number 071-2779-XX.
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list of, 11
selecting, 11

Min readout, 87

N
network connection, 5

O
operating specifications, 3
Options, 2
Overlay View display, 92

P
password, 4

Perceptual Difference node, 29
Perceptual Difference settings

Summary Node, 40
power supply

requirements, 5
processing node

adding, 18
removing, 18

PSNR node, 32
PSNR settings

Summary Node, 40

R
Region of Interest (ROI), 66
results location, 83

S
Safety Summary, iii
save location of results, 83
Save Results settings

Summary Node, 41
selecting a measurement, 11
software upgrades, x
Spatial Alignment

automatic, 63
manual, 59

Spatial Gradient Artifacts, 33
Spatial ROI, 66, 97
specifications

operating, 3
power supply, 5

Summary node, 39
Summary View display, 85
supported formats

generating video signals, 71
video files, 42

supported video formats, 73
Swap OUT1↔OUT2 button, 77
swapping output channels, 77

T
temporal alignment

low correlation, 151
Temporal ROI, 66, 100
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automatic, 55, 57
manual, 50

Tile View display, 88

U
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Temporal Sync tab, 52

user name, 4

V
video clips

comparing, 90
video formats supported, 73

generating video signals, 71
video files, 42

video signal
capturing, 78
generating, 73

View Model node, 26
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